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Prota shall not be held responsible for any losses caused by
documentation, software, or usage errors.

In addition to Prota License Agreement Terms, it is the responsibility of
the user

e to check of results generated by documentation and software,

e make sure that the users of the software and their supervisors
have adequate technical capabilities,

e make sure that the software is used correctly per the reference
manual and documentation,

ProtaStructure is a registered trademark of Prota Software Inc. All
intellectual property rights belong to Prota Software Inc. Documentation,
training, and reference manuals, and program components can not be
copied, distributed, and used in violation of the license agreement.

ProtaStructure®, ProtaDetails®, ProtaSteel® ve ProtaBIM® are registered
trademarks of Prota Software Inc. Prota logo is a trademark of Prota
Software Inc.
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Introduction

Thank you for choosing ProtaStructure. This Quick Start Guide aims to get you up and running quickly.
You should be able to model, analyse and review the results for this simple model in around 1 hour.

User Interface

ProtaStructure 2024 welcomes you with a modern & efficient user interface designed from scratch for
ease of use. The various components of the ProtaStructure user interface are as shown below:

OB Y v a _Complete_R7 Beam Options m - &8 x
e Modelg Load Revew Ay Owwn  OawegsAReos  SM  Daer  Vews e | Bem | Command for the
L e B, BE B & W P re M © | o selected ribbon
| Refresh, Rotate, Zoom L ] Merge Buidng LikedModel [FC Import OVF Inport SAF Impart  Rewt Extemn Materiss msiys
nal X Close Project Models Manager Import  Reference Drawing P N
M Project Quik Start Materiais Settings ~
C® i oo x| .
Search
<R ke & Plan View i 3D View
+E vews

* Storey: 2 (Plan)

Structure Tree

» © St:0(+0.00m)

» © 5t 1(+3.00m, Sm:2,3)

4 © St:2(+6.00m, Sim:1,3)
» (| Cokemns
» f Shearwals
4+ (7 Beams

32 . l
§—— Views g j;—‘
= e
= o— iy

29

Ribbon User Interface

B Building Setout = Modeling  Loading  Review Analysis  Design  Drawings &Reports  BIM Display Views  Help
™ ([ RecentProjects - Save N ! 4
B~ e BE HY W & Y re #
— "“ Open Previous Backup E Save As 1 Lo
New Open Merge Building Linked Model IFC Import DXF Import SAF Import Revit External
|%&] Save Thumbnail X| Close Project] Models Manager Import  Reference Drawing
Project Quick Start External Reference Drawin:

Imports an architectural plan as reference drawing to
ProtaStructure

1. Select and load the DXF file.

2. Choose the unit that the drawing has been
ceated.

3. Specify the scale and insertion point.

The ribbon consists of several toolbars placed on various tabs. Each toolbar contains related commands
organized into logical & functional groups. Placing the mouse cursor over the command will reveal the
Tooltip explaining how to use the function.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Generally, you create the model from the left to right ribbon tab.
i.e., start with Building Setout > Modelling > Loading > Review > Analysis > Design > Drawings & Report.

Quick Access Toolbar

The Quick Access toolbar displays commonly used commands. Any command can be added to the Quick
Access toolbar by right-clicking on the command = Add to Quick Access Toolbar.

OB & & R~
Building Setout Modelhng\mg Review Analysis Design Drawings & Reports

Ll

H b 3B P £ H

Load Cases and Seismic Wind and Partition lab Additional Point, Line Pattern Loading
Combinations Parameters Storeyloads  Wall Loads = it Definitions
LateralLoads Add to Quick Access Toolbar

Show Quick Access Toolbar Below the Ribbon

Structure Tree Search Option

Are you looking for a specific member or object? Type in the member label in the structure tree’s search
box and let ProtaStructure find it for you.

colf caa
i
4 H structure

4 ff€ Storeys

4 0 St 1(+3.00m, Sim:2,3)
4 || Columns

v 1C1
v 1C10
Views
| Review Analysis Design Drawings & Reports BIM Display Views Help
P 3D il (s
Reset Tile Horizontal Tile Vertical Smart Plan 3D Physical 3D Rebar
Model Model
Window Create View

Create as many views as you need, such as a plan, 3D physical Model, Analytical Model, and 3D rebars.
Views can be organized using smart window layout options.

Customize your work area by docking and floating views. The interface is compatible with multiple
monitors. If you want to make the most of your screen’s cape, just move one of the views to another
screen.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Display Settings @ (under Building Setout tab)

Colours: Choose the background colour and various active

modelling objects

Object Snap

Graphics Performance

Grid: Sets the spacing of the grid system to allow ease of
modelling as objects can snap to the intersection of the
grids

Object Snap: Choose the various snap options such as
Start/End/Corner, Perpendicular or Orthogonal Grid, etc.

Graphics Performance: Options that affect graphics
performance. Defaults will give optimal performance.

Visual Interrogation =~ (under Review tab)

Visual Interrogation: Colour-code members to various criteria
such as design status, material types, beam with wall loads. It
is a vital visual tool to check and verify the inputs and results
of the model.

Scene Settings: Control the views’ graphics and switch on/off
the guiding Grids & Coordinate Axis, etc.

Visibility Filters: Filter to the specific storey, Axis, or member
type.

Column Plan Display: The column wall axial, moment & shear
forces to be displayed on the plan view.

Beam Plan Display: Allows brick/partition wall label, load
value & height to be color-coded and displayed in the plan
view. In addition, you can show the total user-defined load
(only after the analysis) & display beam elevation marks.

Page - 8

Background Style: Solid
Top Color: [ white

—
Selection Color: . 240, 0,0
Highlight Color: I 240, 0, 0
Insertion Point Color: I Red
Insertion Line Color: . e
Insertion Line Thickness:
Axis Indicator Color: [ Orange

Visual Interrogation
Scene Settings
Entity Edges
Hiddenline Properties
Visibility Filters
Column Plan Display
Beam Plan Display
Slab Plan Display

FE Contours

Animation

Active Windows Settings and Visual Interrogation

Criteria for recoloring:

Section and Material
Column Sections
Beam Sections
Wall Thickness
Slab Thickness
Materials
Loads
Beam Wall Loads
Slab Additional Dead Loads
Slab Live Loads
Beams with User Defined Loads
Beams using F.E. Slab Loads
Beams Using F.E. Slab Analysis Results
Column Nodal Loads
Column Span Loads
Members with Temperature Difference
Design
Design Status
Pile Capacity Status
Joint Shear Chedk
Member Performance Status
Seismic Isolators
Seismic Isolator Type
Seismic Isolator Lateral Stiffness
Seismic Isolator Axial Stiffness

0K

Slab Plan Display: The plan view shows the dead and live load values.

FE Contours: Shows the FE contours exported from the FE Analysis Post-Processing

Animation: Animate by spinning the model in 3D view

Each modelling window can have separate view settings.

For example, you might want to colour the slab live loads on the plan view, and at the same time, colour

design status in the 3D view.

ProtaStructure® ProtaSteel’

ProtaDetails’

ProtaBIM’
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Active Windows Settings and Visual Interrogation

Visual Interrogation
Scene Settings
Entity Edges

)

Hiddenline Properties

Visibility Filters

~~~~~~ ®—O+

Column Display
Beam Plan Display
Slab Plan Display

Animation

Animation - -

Animate Camera | s + ‘ % {,\,.-

Compass / | oO— § o o=
| Coordinate Axis | Grid |
Bounding Box /| Show Axis Auto Dimensions €p— - > :
> L
» * !

In the Scene Settings tab, the grid allows you to switch on/off the grey rectangular grids in the
background. Coordinate Axis will enable you to switch on/off the coordinate symbol. Show Axis Auto
Dimensions enable to switch on/off the auto dimension between axes.

Layer Toolbars (under Display Tab)

= Switch on/off layers and modify the name, colour, opacity, line type, line

Layer and colour settings
4 g g weight, font type, and text height.

Axis Layer Group switch on/off the axes layer

Column Layer Group ZU switch on/off the column layer
Wall Layer Group _II i switch on/off the wall layer
=
Partition Wall Layer ) switch on/off the partition/brick wall layer

Beam Layer Group switch on/off the beam layer

Slab Layer Group switch on/off the slab layer

Slab Load Layer Group switch on/off the slab load layer

switch on/off the slab strip layer

=/
Ribbed Slab Layer Group ?m switch on/off the ribbed slab layer
y
Slab Strip Layer Group §= =t
—=—

Steel Bars Layer switch on/off the slab reinforcement layer

Steel Member Layer (’I:j?b Switch on/off steel members such as truss, brace, purlins, girts, etc
Ghost Axis Layer Group ?? switch on/off the ghost axis layer
- =1\ , -
Plane Definition Layer P switch on/off the plane definition layer
Text Layer Group Iiéc switch on/off all the texts
Footing Layer Group :1}_"1 switch on/off the footing layer

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Start Page

When the ProtaStructure is launched, the “Start Page” will appear.

o8 2~k

“ SuldogSetout  Modeling  loadng  Review  Andyss  Design  Orawings&Reports EIM  Display  Views  Hep

) ([Drecentprojects - B Iy » \ - Re -
j o 8 A# A [ i RO ; 9 g: B
New Open x
0 X ’ <
Project Quek start Materials Settngs

Page -

B > @ = =]

Load Lbrares Storeys

cet Qad

Account Name:
Recent Projects

421K IAP1 KUBUIGERBANG V2.
D'\chunfeiDocuments\User Modeh . 04211 1411212021
14122021 S iption ired

Click to extend your subscription
0421.IPK-3AM1-REV2_R6
D\chunfel\Documents\User Model, ... 0421...
14122021

Software Updates
01_IP163_4A_GA01_BIkB_03_BF_R6
D ‘chunfeiDocuments'User Model.  01_IP1
6.0.163

Your software is up-to-date.
Quick_Start_Guide_Steel_Complete...

CUsersiLenovoiDocuments\ProtaData2022\ Up-To-Date
1411272021
6.0.163
Your software is up-to-date.

QsG_13_155

C\Users\LenovolDocuments'ProtaData2022\... Big Title

141222021 Tite
Description
Click here

Resources

1

@ Getting Started 1.7 What's New
H

Help Center o Training Videos

Design Guide Tips & Tricks

News / Videos

Breaking News! This is just another news text
12102021

Attention! This is an announcmenet text.

121102021

New videos leaked from ProtaSoftware developer team
Click 1o watch

121102021

Bl | Ge:mm, Ack: kNm , D m

The Start Page contains the following functions:

Open existing project
Start a new project
Read Prota News and watch Prota Videos

R/ 7 R/ R/ 7 R/
0.0 0.0 0.0 0.0 0.0 0.0

View Subscription status

Access Prota Resources such as Help Centre, What” New document & Quick Start Guide
Read important Notification and download new software Update

You can always open the Start Page by going to the Help tab > Start Page.

Software update is checked automatically when there is internet connection.

ProtaStructure” ProtaSteel ProtaDetails’

ProtaBIM"
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» Click Open Project in the Start Page & the Open Project dialog will appear.
Here is the explanation of the functions in this dialog :
Open Project...
Project Data Folder: 1 Quick_Start_Guide_Concrete_Complete
C:\Users\beoooe \Documents\ProtaData 2024\ 2 v 6 Made By:
Choose / Create Folder 3 Explore 4 Checked by
9 Al Projects Al Releases - Member Concrete Rebar Steel
Column C30/37 Grade 500 (Type 2)
Most Recently Used Projects 7 0 A-Z Date Shearwal C30/37 Grade 500 (Type 2)
x T Beam C30/37 Grade 500 (Type 2)
: Slab C30/37 Grade 500 (Type 2)
Quick_Start_Guide_Concrete_Complete >
Quick_Start_Guide_Steel_Complete 5 Bh Stb c30/37 Grade 500 (Type 2)
Footing C30/37 Grade 500 (Type 2)
Link Grade 500 (Type 2)
~ ~ + Codes:Eurocode 2 (SG).Eurocode 1 (SG).Eurocode 3 (SG)
ProtaStructure R7.0 Q
Number of Storeys:4
Project Last Saved Date:24/04/2019 11:02:12 8
(2] v X
Help oK Cancel

1. The Project Data Folder is the main folder where the project models are stored.
The project model consists of several files stored in a single folder called the Project folder. This
Project folder is created as a subfolder in the Project Data Folder. The project folder name will
always be created precisely the same as the project name.

A

A Data Folder called ProtaData2024 would be installed under My Documents by default.
If required, you can specify a different location by clicking Choose/Create Folder.
Clicking on Explore will open the current Project Data Folder in windows explorer.

You can open existing projects stored in this Data Folder by selecting the project list

After selecting the project, a preview of the project will be shown on the right-hand side
Double-clicking on the project name or clicking OK will open the project.

N

8. You can also read Project Last Saved Date to locate the saved project quickly.

Previous versions of ProtaStructure model can be opened directly in PS 2024

Click on the dropdown list below to expose the most recent accessed Data Folders.
Tick Most Recently Used Projects to show the recent projects opened quickly.

» Firstly, you must choose the correct Data Folder by clicking Choose/Create Folder.

YV V V V V

compatible).

ProtaStructure’

After converting, the project will open.

ProtaSteel’

You will then be able to see the project and open it.

You will be prompted to save the model as another name.

ProtaDetails’

ProtaBIM’

Browse to the desired Data Folder (note data folder is the main folder, not the project folder)

Newer version projects can’t be opened in older versions of ProtaStructure (not backward
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» Click New Project O and type the project name as shown using the *_’ character for spaces.

» Select Singapore (Eurocode) template

New Project

Project Code: |Quick_Start_Guide

Templates

Search....

Malaysia (BS Code)

Malaysia (EuroCode, EC8-DCL)
Malaysia (EuroCode, EC8-DCM)
Malaysia (EuroCode)

Peru (NTE)

Philippines (US Code, NSCP)
Poland (EuroCode)

Singapore (CP65)

(Available Characters: A-Z, a-z,0-9, _, -)

J

South Africa (BS Code)
South Africa (EuroCode)
Thailand (US Code, DPT)
Turkey (TS500, TBEC2018)
Turkey (TS500, TEC2007)
United Kingdom (BS Code)

® Templates: Projects

a

Cancel

Page - 12

Templates are used to rapidly establish default model parameters such as design codes, material
properties, member design settings, etc. Alternatively, you can choose to duplicate settings from an

existing project by picking “Projects”.
» Click OK.

The main modelling area will now show a set of rectangular grids in the background.

By default, these girds spacing is 1m with a major grid coloured darker every 5m. The defaults can be

changed via the Display Setting button E@ under Review tab.

ProtaStructure” ProtaSteel

ProtaDetails’

ProtaBIM"
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Settings Centre

The Setting Centre can be accessed by clicking on the Settings icon in the Quick Access Toolbar or from
the Display tab (as shown below).

. B = ™ *@« Protas protaftruciure X2X t:‘:kjtanﬁu»de

Building Setout Modeliing Loading Review Analysis Design Drawings & Reports BIM Display Views Help
‘j  — @ Recent Projects - B Save & A -y "‘i e _f_ -
« * ]| H
(% OpenPreviousBackup [ Save As H H RS [ g %
New Open Load Building Linked Model  Import Import External Materials Settings | Layers and Display
[ff] save Thumbnail X| Close Project Model Manager FromIFC fromRevit Reference Drawing Center | Color Settings Settings
Project Quick Start Materials Settings

The Settings Centre centralizes all the program’s default settings, including analysis, design and
detailing, and Units & format settings.

Options
Search Settings... ™
General Language Settings
i Don't Check Model During Member Insertion
" ProtaStructure Environment 9 Display Language: | i Engish | v
{General Angle Step: 5.0¢°
Display Settings —
b ‘ Protalletails Emironment Length Step: 100 mm Report Language: EH English v
- Member Section Eccentricity Step: 25 mm
» “ Project Preferences Plan View Direction (Project Based)
@i Unit and Format
» ﬁ Label Member Tooltip Window ® Top Bottom
) Codes | Display Icon
:f Lateral Loading AutoSave
[ Lateral Drift & Bracing | Display Member Type Automatic Save Interval: 0 : minutes
| Display Member Label
b [] Column & Shearwall (Automatic Save Option will be Disable when Interval is '0'.)
w| Display Basic Properties
» ¢ Beam Prompt for Automatic Saving
+ ~ Slab | Display All Properties
+ AL Foundation v Backup Structural Model
= . —Tooltip Preferences
@ Stairs Number of Backups to Save: 38
il Retrofit wall | Show Tool Tips
T - | Return License on Shutdown
b ¢# Steel Settings Tool tip Delay (sec.): 1.0
» f#n Analytical Model Settings 2 Show Detaied Tool T I
¥ 1fi- Load Editor Settings ow Detaled 100! Tips Theme Selection
@a Assesment Settings Tool tip Delay (sec.): 1.0 Theme: |Office 2013 v
7! Scales Export to ProtaSteel Structure Tree
3 Rebar
b g Plan Details Allow Prota Steel to Launch Without a Valid Analysis Display Sections on Structure Tree
(Connection Design won't be possible) . e o € L
T Template Management

For example, when you initially start a project, it’s advisable to review the Automatic Save Interval in
the General settings. By default, “0” means it’s disabled.

» Change the Automatic Save Interval to 10 minutes to ensure the model is auto-saved.

» Untick Prompt for Automatic Saving to set the auto-save to run silently in the background.

Backup Structural Model

The Number of Backups to Save refers to the automatic & silent additional backup created every full
hour. For example, the 1%t backup file will be created at 9:00 am sharp, 2" backup at 10:00 & 3™ backup
at 11:00. At 12:00 pm, the backup will overwrite the 1°* backup, and the cycle continues.

The backup zip files can be found in a folder called “Backup” in the same Project Data Folder. The files
name will have the date and time stamp (example shown below)

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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™ « Documents > ProtaData202X > DataBackup

~

~ [ Name

»

” ™ QSG1(R001.00022020.1600).zip
o % QSG1(R001.00032020.1400).zip
» % QSG1(R001.00032020.1700) zip

To restore the backup, there are 2 options :
1. If the model can be opened, go to File menu > pick Open Previous Backup.
2. If the model can’t be opened, manually extract the backup zip file and replace all files to the

same project folder, over-writing the existing files.

|

Project Template 7=

Templates

The available templates are shown when you start a new project, and you must choose one. You can
access these templates via the Building Setout tab.

Templates Project Settings:
Search Project... Setting Group Active Value
Brazil (NBR6118) |Z)] Codes and Related Parameters Current Project

Hong Kong (COP)
India (Indian Codes)
Indonesia (US Code, IBC) ﬁi Load Case and Combinations Current Project
Indonesia (US Code, SNI)
Ireland (EuroCode) -

iMalaysia (BS Code) lE (# Beam Design Settings Current Project
Malaysia (EuroCode, EC8-DCL)

@1 Analysis Model Parameters Current Project

() Column Design Settings Current Project

Malaysia (EuroCode, EC3-DCM) £ Slab Settings Current Project
:::i";::_E()E“mC"de) &) Stair Design Settings Current Project
Philippines (US Code, NSCP) il Retrofit Wall Settings Current Project
Poland (EuroCode) ) Import X
Singapare (CPES) B AL Footing Settings Current Project
Singapore (EuroCode) T Export D £ slab Additional Loads Current Project
South Africa (BS Code)
South Africa (EuroCode) {@ Partition Wal Loads Current Project
Thailand (US Code, DPT) o9

25 M i Py
Turkey (TS50, TBEC2018) oo Materials Current Project
Turkey (TS500, TEC2007) =-| Detail Drawing Settings Current Project
United Kingdom (BS Code) - .
United Kingdom (EuroCode) @ View Settings Current Project
United States (IBC, Imperial) H: Labels Current Project
United States (IBC, Metric)
United States (UBC, Imperial) {6 Unit And Format Settings Current Project
United States (UBC, Metric) g Layers Current Project
My template B _ .

|__»,’| Dimension Style Settings Current Project
o Templates: Projects

x Select Al % New Template A

Importing an existing Template > refer to step 1,2,3 above

You can change the template of a currently opened project by selecting a different template and
Importing it :

» Pick a Template (1) = Pick Select All (2) 2 Import (3)

All the settings of the imported template will apply to the current project.

Exporting a new Template - refer to step A, B, C, D above

You can save the settings of your current project as your template by Exporting it :

» Pick New Template (A) = Give it a name = OK - The new template will be created (B)
» Select the new template (B) = Select All (C) = Export (D)

The template will be successfully exported & can be re-used the next time you start a new project.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Selection Methods

Selection is performed by placing the mouse cursor on a member or Axis in the modelling view. Although
there is no entity to select now, the information is essential as you work through the model.

> Left-click on the entity to select the entity. Selected entities are also highlighted in the Structure
Tree

» To select multiple entities, hold down the CTRL key while you pick them

» You can select entities directly from the Structure Tree

You can drag with the mouse to access further selection options:

» Drag from left to right to create a rectangular box. When you release the mouse button, all
entities wholly contained within the box will be selected
» Drag from right to left similarly, and all the entities that cross its boundaries will be selected

If you right-click the selected entities, you will see a pop-out context menu that allows you to edit and
perform other tasks related to that entity, such as Properties, Delete, etc.

Pressing ESC will deselect all entities.

Zoom & Pan Methods

The useful functions for zoom are just above the structure tree :
» Zoom Window & - Zoom into the area defined by dragging a rectangle.
» Zoom Previous X -> Zoom to the previous view.

» Zoom Extents & - zooms to the selected entities. If no entities are selected, it will
zoom to show all entities.

You will find it easiest to use the mouse wheel to:
» Zoom in - scroll your mouse wheel up
» Zoomout - scroll the mouse wheel down
» Pan (move) - hold down the middle mouse wheel and drag

Modelling Axes

The very first step to building a model is to define axes. Axes intersections then become the nodes at
which members are inserted. Hence, axes must be created correctly. There are three ways to model
axes:

1. Axis toolbar to build axes individually

2. External Reference Drawing to import all axes from the DXF drawing file.

3. Orthogonal Axis Generator to create a system of axes quickly

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Axis / Grid Tool o,
Modelling individual axes is simple using the program’s Dynamic Input System (DIS). i

» Click on Grid icon in the Modelling tab.

There are several insertion methods for the Axis:
Axis X

e Single Segment allows you to create a straight-line axis by clicking

Label: AlS . .
on the start and endpoint of the Axis.

Visble in Current Storey:

Length: H Multi-segment axis enables you to create a single axis with
Angle: multiple segments of any shape

Insertion Method:

7 77| ¢ Curve Axis can be created by specifying the radius

» Ensure Single Segment insertion is selected.

» Put the mouse cursor on any of the grey grid intersections & the “Grid Intersection” snap is
shown.

_"Erid Intersection
ar

» Left-click (& release) to confirm the start point .

A “rubber band” will appear as you move your mouse cursor to specify the endpoint.

Sy= 4397 My=1715

The length (L) and local angle will be displayed during the rubber band operation. In addition,
the relative distance Ax & Ay to the local UCS will also be shown.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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» Press F2 to enable input of the length (L) of Axis via Dynamic Input System (DIS)

»  Press TAB to cycle to the following input of angle

The related parameter will be locked if a value is
entered in the textbox. You can unlock by pressing ESC
Em & or pressing the lock icon at the right of the text box.

If a textbox is locked and F2 or ENTER is pressed, DIS
will be deactivated. However, rubber band operation
now continues with the locked parameter for ease of

&

2= 4508, &y = 3373 use.

The left figure shows the length L is locked, o
so you can freely rotate the Axis without
changing the length.

e If both text boxes are locked, pressing ENTER will accept the operation, and the candidate
point will automatically be picked.

e In either of the text boxes, you can use shortcut notation Length<Angle or Delta-X, Delta-Y
(without the need to switch by TAB.)

Length<Angle DeltaX,Delta¥ "
AO00<45 & 6000,2000 (5
o o
Poe= 3404, Ay = 2133 P = 3405, A= 2133

e Holding down the CTRL key when the rubber band appears will lock the length & angle
increment as defined in Settings Centre = ProtaStructure Environment - General = Angle
Step & Length Step input box.

» After specifying the length or angle, pressing ENTER or left-click will accept the endpoint.

» Tryinserting a multi-segment axis ™~ by defining points continuously.

A=4000, Ay=-2000

Grid Intersection
+

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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e Use F2, TAB, ENTER to define destination points as mentioned earlier.

e Pressing ESC will cause a smart roll-back. If parameters are locked, the DIS is unlocked, then the
operation is cancelled. If a pick-continuous command is active, ESC will unpick points.

» Right-click to end the operation and insert the axis.

e You are in axes creation mode when the axis property dialog is shown. Close it, if you want to
end the creation of an axis. The same step applies to all member properties dialog.

> Insert a curve axis by clicking on the curve axis icon. 4

Click on the 1° point and then the 2™ point.

> Move the mouse cursor to the 3™ point that will specify the offset length of the curve.

> Left-click to confirm the 3" point = Curve axis will be created

e Alternatively, hit F2 to specify the offset length manually.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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External Reference Drawing

Note: This section is for information. A DXF drawing is required if you want to try out this feature.

ProtaStructure lets you load external DXF drawings and show them as ghost reference layers under your
model. The External Reference Drawing button can be found under the Quick Start menu.

Building Setout Modeliing Loading Review Analysis Design Drawings & Reports BIM Display Views Help
\‘ ™ [ RecentProjects - B Save < N \J -y Y
= * H : 4 @ 4
‘— Open Previous Backup E Save As ﬁ (X Lz.‘d R ‘ [
New Open Merge Building Linked Model IFC Import DXF Import SAF Import Revit External
[#] Save Thumbnail X| Close Project Models Manager Import | Reference Drawing

Project Quick Start

This tool allows you to assign DXF drawings to different stories. Properties like unit, opacity, scale factor,
and offset can be set individually for each imported file. The whole state will be saved along with the
project data and restored; the next time the project gets opened.

Important! The referenced DXF files should be intact to restore the external drawing layer next time the
project gets loaded.

Storey Reference Drawing
Active | Storey N... | File Path Unit | Use Colors | Opacity | Scale Factor | Offset
w 1 C:\Users\User\Documents\SAMPLES_DXF\Architectural\DURULTUCU MIMAR... mm ' = 10 ¥ =-247.86,Y = -708.32
W 2 C:\Wsers\User\Documents\SAMPLES _D¥F\Architectural\DURULTUCU MIMAR.... mm ' = 10 X=0,%=0
P 4 C:\UsersUser'\Documents\SAMPLES_DXF\Architectural\Architectural_Plan... .| w W = 1a K=07%Y=0
mm
m
m
Please dick "Add” button to add a new external |
Add %7 Remove f-i» Move Import | reference drawing file for a selected storey. c A4 x
shd U] shd Help F1 0K Cancel
e

Click Add to select and load a DXF file. The file will be converted into 2D drawing entities inside
ProtaStructure directly upon loading. However, it will not be visible until the Active box is checked.

Active

This checkbox controls the visibility status of the external drawing.

Unit

Please select the correct unit of the DXF file from the table’s unit column right after the file’s loading.
The drawing will be scaled immediately.

Storey No

The imported file will be assigned to the active story initially. You can use the ‘Storey No.” column to set
it to any other level. Only one drawing can be attached to a specific storey.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Use Colours

If this field is checked, colours defined in the file will be used; a grayscale drawing is displayed if
unchecked.

Opacity

This parameter controls the opacity of the colours. This field applies only if drawing colours are selected
to be used.

Scale Factor

This factor scales the whole drawing.

Move & Offset

Click the Move button and pick two points on the plan view to move the external drawing. Dynamic
Input functionality (hit F2) can be used here as well. The offset value between the two picked points will
be shown in the Offset column of the table.

BALCUNY M
ct

nd Point e
(WS )
VY
| T

Import

The selected reference drawing can be imported into the assigned story. In this case, the Import DXF
interface will be loaded with a pre-defined level and file unit values. The drawing can be imported to
the existing model in this mode.

A complete model can be developed from scratch in a controlled environment using the External
Reference Drawing interface and Import option.

For more guidance, e.g. 3D Physical Model & 3D Analytical Model import, kindly refer to Prota Help
Centre : I[FC and DXF Import Guideline

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Orthogonal Axis Generator

Let us now start the new model by creating the required model axes. We will define multiple axes in
one go using the Orthogonal Axis Generator.

» Select all existing axes that you have created = press Delete (or right-click - Delete)

@

> Go to the Modelling tab > Select Orthogonal Axis Generator -+

Refer to the bottom status bar; the displayed text tells you how to proceed.

Pick the Reference Point (Lower /Left) of the Asxds Group...

» Pick the intersection of any two primary grids near the origin (as shown below)

_"L}‘nd Intersection
ar

Direction 1 axes are placed horizontally with alphabetic labels (incremented from bottom to top).
Direction 2 axes are aligned vertically with numeric labels (incremented from left to right).

» Accept all the default values in the inputs and click OK

Orthogonal Axis Generator

Grid Insertion

Reference Point - x: 5000 mm -y: 5000 mm

®

Insertion Angle: 0.0°

Dir-1 Axes

Axis Label: D Step: 4

®
@

Axis Spading(s): |5000%3
Axis Extension Length: 2000 mm
Dir-2 Axes
Axis Label: |1 Step: 1 |
Axis Spadng(s): |5000%3 |

Axis Extension Length: 2000 mm

Axis label increment to be used for generating the successive labels.

®

a v X
Help F1 oK Cancel N o

L e T B e o o o e e e e e e e

- SN0 S s '~

Four horizontal and vertical axes with a 5 m spacing will be created.

If a reversed axis label is desired, then enter “Step” = -1. For example, for Dir-1 Axes, if you want
Axis A to start from the top instead of bottom, enter “Axis Label” = D (last label) and “Step” = -1

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Columns Creation

» Pick RC Column icon U

» Use the default size b1 & b2 and eccentricity e2 & e2 is as shown below

Column x
Gen Geo
Label: 1c1(s T Dir-2 Axis
Len (Storey): 1 .
Column
bi1: 500 mm l Reference Point
+, b2: 250 mm !
b el: 0 mm b2 &2 ! / Dir-1 Axis
p: e2: 0mm F__l-_-—-_-_’
Top: 1
Bot: A 1
0 9|e1%
Bot Insertion Point: h
bl
Angle: 0.0°
I Dir: | 1f2 1 2
 Update % Close el & e2 is measure from the centroid of the column

Section Manager : Allows access other section types such as circular, “L”, “T”.

ﬂ Column End Condition : Columns ends are fixed by default. You can apply hinges to top and/or
bottom by clicking successively on this icon.

Column Concrete (500x250-C)

Database Project General Properties
Concrete v Section Name: | 500x250-C Material Color [ 192, 192, 192 |v
B 500.0 mm
H 250.0 mm
a 0.0°

> Hide Labels

Section Angle: d
Mirror About:  X-X Y-Y

Materials

Conarete [Defauit]

» Insert columns by clicking on the intersection of axes

» Multiple columns can be inserted by dragging a box around the intersection of axes

Using the two methods, create ten columns at positions shown below.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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| | | i

| | | i

| | | i

[ | | i

[ | | i
| o
& o - L

| | | i

A A il L

() (1) )] (4

» Close the column properties. You finish member creation.

Always close member properties when you finish member creation, otherwise you will be
unable to proceed to other functions, such as member selection.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Walls Creation

» Click on the Wall icon m & the wall properties will appear

» Use the default wall thickness b =250mm & e =0 mm

The parameters are explained in the diagram below

<+
Ext|

e is measured from the centreline of the wall to its centroid. e = 0 means that the centreline of the wall

1wl (3020x230)

Centroid

coincides with the centroid of the wall.

Page - 24

ExtJ

» Insert three walls by simply clicking on the shear wall’s start and end node.

oL
i i

@ L

l
|
|
|
|

a—
| |

]
® ®

Ext | & J : Slight extension to lengthen the wall should be kept small; less than its width as the

®

®

®
————®)
e ©
— &
®

®

extension cannot support any members, such as beams.

wall X
Gen - Geo

s [zt

Len (Storey): 1

Q (mm) b: 250 rnrn|
e 0 mm

Ext. I: | 125 mm

= 2 125 mm|

& Update || ¥ Cancel

ProtaStructure’

ProtaSteel
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Beams Creation

»  Click on the Beam icon & = Pick Normal =2 the beam properties will appear.

General |
H i *
Labets 81 Insertion J
Type: |Normal v Boris
&
{mm) b: 250 mm ]
ghe e 0mm :
fel |
= he 500 mm e-7 '
=, - ] J..T_ — .
= ez 0mm e i T Bvel
. = . T !
Jend| A r h I,‘e_,
Section | !
e 0.0 :
Curved Beam Inserton: | Y

Bearn Reference Point

End Releases b “qe
N V2 V3 T M2 M3

) Bearn Parameters

(WPipdete | [3€ o

e is measured from the beam’s centreline to its sectional area centroid. e = 0 means that the beam’s
centreline coincides with its area centroid.

e-z: +ve value raise the beam from the story level, -ve lowers the beam
End Releases: Beam ends are fixed by default. To release forces (N,V,T,M), check the box(s).

<" Click successively on this icon to hinge & release all moments to the left or right end of beam.

» In the beam properties, use the defaults values b = 250 mm & h = 500 mm (as shown above)
» To create a beam, pick the start and the endpoints by clicking on the intersection of axes

Notice that you can continuously create the beams from the previous beam.

.IJ'-- Y Fah \ F
'\\ 2 /: \ 3 } \
- et

| |
== — ( I/ Ij:l /b;
| | .

> Right-click to end the beam insertion after inserting the two beams as shown above

—-1l-h-|

Multiple beams can also be inserted by dragging a box enclosing the area you want to insert beams.
Beams will automatically be created between columns and walls.

i

T
T
|
|
|
|
|
¢

» (Click and drag box enclosing the columns & walls shown above.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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o)
)

ey

)

o/ : ul =/

Seven (7) new beams will be created.

» Insert the rest of the beams by any method as shown below

4 j ShearWalls
w1
w2
1W3

4 (7 Beams
1B1
1610
1B11
1B12
1613
1614
1815
1B16
1817
1B18
182
1B3
164
1B5
186
1B7
1868
189

&7 Slabs
iw” Ribbed Slabs
£ slab Strips

o)
=/

|
\

" ®

®

"/

o
(»)

Check the folder Beams in the Structure Tree to ensure you have inserted a total of 18 beams.
We will now insert a curve beam in the lower right corner of the model.
Click on the curve beam insertion icon d in the Beam Properties dialog

Click on the intersection of axes A/3 and then the intersection of axes B/4 (i.e., start & end of the
beam)

Jﬁ&' bi S {é\ Beam *
| | — Generd | 3
| ) Label: 1819 |
Type: |Normal v
| | (mm) b: 250 mm
A e 0mm
; < W= 1050, &y /51050 = o
. 1€nd 3 @2
’ JEnd 4 @2
T KA/J Curved Beam Insertion:
l £nd Releases
N V2 V3 T M2 M3
1 1
A J .
(3) (4 7 Upcite X cose
L/ N/
ProtaStructure’ ProtaSteel’  ProtaDetails’ ProtaBIM’
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Define the apex distance by simply moving the mouse cursor, and the preview of the curve beam in
grey will show automatically.

» Press F2 to define the apex exactly as -1500 mm & press ENTER

A curve beam will be inserted (segments are automatically created). Check the Structure Tree that
you have modelled for a total of 19 beams.

(7 Beams
1B1
182
183 O =
184
1B5
186
187
1B8
1B9
1B10
1B11
1B12
1B13
1B14
1B15
1B16
1B17
1813 ) —1—®
1B19

. Slabs

i Ribbed Slabs

B ——@®
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Beams Creation using dynamic snap points

Note: This section is optional and is not part of the final model, but you might want to try it anyway.
Secondary beams can easily be inserted using dynamic snap points (without creating axes).

> Click the Beam icon & place the cursor on the edge of the primary beam (avoid the Axis)

g

Place cursor on
edge of beam

4] o o 18I0 @ @ b
A

Notice that snap points on 0.25L, 0.33L, 0.5L, 0.67L, 0.75L will be shown when the cursor is placed on
the beam.

» Click on 0.67L as the start point of the secondary beam.

» Place the cursor on the destination beam

1B3-250x500

Notice that 0.25L, 0.33L, 0.5L, 0.67L, 0.75L & perpendicular point will appear

» Select the desired point as the endpoint of the secondary beam & a new beam will be created

Pressing F2 while the cursor is at any of the snap points will allow input of the exact distance from the
start of the beam.

1 /
| B B a3 250x500

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Pressing the CTRL key while the cursor is placed on the edge line of the primary beam will expose a
distance increment of 100 mm. Left-click to select the desired distance (while still holding down the
CTRL key).

EEEES

The step increment can be set Building Setout —> Settings Centre —> ProtaStructure Environment —
General 2 Length Step.

Options
- General
y ° ProtaStructure Environment A Don't Check Model During Member Insertion
Display Settings
v ° ProtaDetails Environment Length Step:

Member Section Eccentricity Step: 25 mm
» .= Proiect Preferences

Handy Tip to adjust the position of columns and beams

You can change the position (eccentricity) of the column and beam by simply selecting it & then pressing
keyboard arrow keys to move in the direction you want.

/ 4 | / g » Select any column
/ / Y
/ GC 1 V GC 1 » Press right arrow key = to move the
’ £
1]

+ column to the right
‘ \ \

The step by which the member is moved can be set in Building Setout -> Settings Centre —>
ProtaStructure Environment - Member Section Eccentricity Step (by default 25mm).

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Load Combinations

Before creating slabs, we need to define the load cases & combinations.

» Go to the Loading tab, click Load Cases and Combinations

Load Combination Editor
P-Delta Analysis Totals
Apply P-Delta Analysis Number of Vertical Load Cases = 0
Approximate slenderness checks using moment Number of Lateral Load Cases = 0
magnification method will not be applied when P-Delta Number of Thermal Loading Cases = 0
analysis is performed.
Number of Stage Construction Load = 0
No | Combination [LLRed ] R/C | steel
L x GLoadmth e o V4
Add Delete e Help F1 oK

You can add new load cases manually and then load combinations. However, it's easiest to use the
Loading Generator to set up load cases and combinations automatically.

» Pick Loading Generator & use the options as shown below and click OK

Automatic Loading Editor

Create Different Combinations for Steel Member Design V.Load Case = 10
Use Cracked Sections in All Vertical Load Combinations As Well H.Load Case = 4

Vertical Load Combinations Horizontal Load Combinations _w IHor\zontaI Load Combinations I
| Define Dead Load Case (G) g

| G+Q+
/| Define Live Load Case (Q)
v Define Pattern Loads Automatically or Symmetic Results

Add Vertical Seismic Case

V=_=_.. v 7 Use ed Se
W _==.. v ==
/| Direction dent Pattern Loadi
Depen 0 | Notional Loading NGx, NQx, NGy, NQy
Define Combinations for Roof Live Load (Qr): Wind Loading EN1991-1-4 (2005) - Singapore Annex
Define Combinations for Snow Load (S):
Define Combinations for Rain Load (R): WindLoad 0 0.6
Stage Cases v
Soil Pressure

Pressure Direction

| Dir-X Positive (+) v
Temperature Loading

v D Positive (+) v

You can choose which combination is used for concrete & steel design separately.

If “Use Cracked Sections” is checked, section stiffness factors, as defined via Material and Section
Effective Stiffness Factors menu, will be applied for that load case.
As shown below, all the load cases and combinations will automatically be generated.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Load Combination Editor
P-Delta Analysis Totals
Apply P-Delta Analysis Number of Vertical Load Cases = 6
Approximate slenderness checks using moment magnification Number of Lateral Load Cases = 4
method will not be applied when P-Delta analysis is performed. Number of Thermal Loading Cases = 0
Number of Stage Construction Load = 0
No | Combination LLRed| R/C | Steel | VOM G Q Qp1 Qp2 Qp3 Qp4 NGx INQx NGy NQy
1 G+Q Cd Cd Cd 135 1.50 0 0 0 0 0 0 0 0
2|G+Qpl v v v 1.35 0 1.50 0 0 0 0 0 0 0
3| G+Qp2 v v v 135 0 0 1.50 0 0 0 0 0 0
4 G+Qp3 V| V| V| 1.35 0 0 0 1.50 0 0 0 0 0
5 G+Qp4 O U U 135 0 0 0 0 150 0 0 0 0
6 | G+Q+Mx v v v 1.35 1,50 0 0 0 0 1,35 1.50 0 0
7| GHx+Q v v v 135 1.05 0 0 0 0 135 1.05 0 0
8| G+Qhx 4 4 4 135 1.50 0 0 0 0 -1..35 1.50 0 0
9 GNx+Q U v v 135 105 0 0 0 0 -1.35 1.05 0 0
10 G+Q+Ny v v v 1.35 1,50 0 0 0 0 0 0 1.35 1.50
11 GHNy+Q v v v 1.35 1.05 0 0 0 0 0 0 1.35 1.05
12 G+Q-Ny o W v 1.35 1.50 0 0 0 0 0 0 -1.35 -1.50
13 GNy+Q 4 4 4 135 1.05 0 0 0 0 0 0 -1.35 -1.05
* x Gg?:?;r  Load Cases a v X
Add Delete i Help F1 OK Cancel
Z|

> Pick OK to save & close the Load Combination Editor.

Slab Creation

> Click on the Slab icon “~ and the slab properties dialog will appear

Slab

General Loads
Label: 1518
roe: [ v imp im
h: 120 mm
Rel.Level: 0mm
Apply Z to Analytical Model m
Conc. Cover: 25 mm
Design Angle: 0.0° E
Label Position o
1 i o o -
? |
Insertion

| 9| Beam Region v

+ Update ¥ Close

—

El

>

Click on the Type box
All the possible Slab Types will appear in pop up menu.

The slab type 1 to 12 relates the slab edge continuity and is
used in the design of the slab reinforced based on the
coefficient / yield-line method.

Type 1 to 12 does not affect the slab load calculation on the
supporting beams, only the design of slab using coefficient
method.

£=I One-way slab. The slab load will only to be
transferred to the 2 supporting beams in the direction of
the span.

The direction of one-way span must be specified in the

Design Angle input box : Andle: 0.0°

Rel. Level adjusts the top level of slab. Default zero means top of slab is at top of storey level. Positive
value raise the slab, vice versa.

Apply 7 to Analytical Model : If checked, the adjustment of Rel. Level above will be considered in analysis,
i.e. the slab level will also be changed analytically.

Label Position icons activate the slab label and control the slab label’s position.

ProtaStructure’
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Insertion method: By default, “Beam Region” is selected. This means the slab will be inserted within the
region bounded by the beams.
» Select Slab Type as 1

For ease in creating this model, we will initially leave Slab Type as 1 for all slabs. Once they have
been created & when we are ready to design the slab, there is a function to automatically set the
correct type for each slab.

» Enter the slab thickness h = 200 mm and concrete cover = 30 mm
» In the Loads tab, enter Service Dead Load = 1.2 kN/m2 and Imposed Load = 3 kN/m2

Different types of service dead load can be defined via Building Setout - Libraries = Slab Additional
Loads

» Position the cursor in the region bounded by beams @GL 3, 4, C, D, and left-click to create a slab.

- - 2 The first slab will be inserted.
The yield line shows the tributary area load this is
“_; :" automatically calculated onto the supporting beams.
AN By default, slab load calculation is done
automatically onto supporting beam using yield-line
< . i~ method.

» Create seven more slabs to give the layout shown below

\
|
HRZER
\
\

_+_
*
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Inserting Cantilever Slabs (Type 12)

Note: This section is optional and is not part of the final model.

Cantilever slabs can be inserted by setting Type = 12 in the slab property. They are inserted by three
clicks - clockwise or counter-clockwise direction does not matter. Cantilever slabs can span more than
one beam or wall.

» Zoom to the top-right corner of the model
» Click on Slab icon & choose Type 12 & enter h = 150mm

» Go to Cantilever tab = Enter L-Cant = 1000 mm (cantilever length)

181250500 @ T
' '
' ! Slab x
Slab x | |
| | .
General | Loads | Cantilever | | General Loads Cantlever
| |
Label: 1593 | | d:
| |
=
| |
181 i 150 mm) : : g o - LCant.: 1000 mm
m Rel.Level: omm | 1§ 6=150
Apply Z to Analytical Model | |9
| |
| | I-End:
Conc. Cover: 30 mm : : JEnd:
Design Angle: 0.0°® | |
|
Label Position | : Pa[apzt
oad:
o | o e | |
Insertion : :
| p00x250) | 1C4 (500%250)
183250500 i }

»  Pick the first intersection of the Axis to define the start of the cantilever

» Pick a second point to define the end of the cantilever

» Move the cursor to the side where it is to be inserted = a grey preview will be shown

»  Pick the third point to confirm & insert the cantilever

To insert a cantilever slab that does not span the entire length of the beam, we must enter values of d
& b-slab in the cantilever slab properties :

» In Slab Properties, enter d = 1000 mm & b-Slab = 2000 mm

Slab x
General | Loads | Cantilever i 2 3
d: 1000 mm ) -
b-Slab: 2000|mm
L-Cant.: 1000 mm ¢ d > < b )
—
RS14
I€nd: 4150
JEnd: |
RC6 RC7

Parapet ] RE2-2501506 .
Load: ~ - - =

Pick the first intersection of the Axis to define the start of the cantilever
Pick a second point to determine the end of the cantilever

Move the cursor to the side where it is to be inserted = a grey preview will be shown

YV V V V

Pick the third point to confirm & insert the cantilever
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Polyline Slab/Column Edge

Note: This section is optional and is not part of the final model.
The slab edge line can be used to create irregular slab shapes
> Click Polyline Slab/Column Edge ©7 under Modelling

» Click continuously to define the edge of the cantilever slab.
| |
2 | 3

= 1000, =1 000
1 GC3 |4 GC4

3508 ] p—— {5 Intersection
= =SB8-250x -
____________ L,_,n________________________%f

The method to draw the edge lines is similar to a multi-segment axis.

» At the last point, right-click & pick Finish to end the insertion. The slab edge lines will be drawn

» Click on the Slab icon = Ensure Type = 1 is selected

Y

In the Insertion, ensure that Beam Region is selected.

» Click anywhere within the slab edge line, and a new slab will be created.

For regular cantilever slab, it is recommended to use Type 12 in slab properties (instead of slab edge
lines).

The slab/column edge line also includes Circle, Arc & Rectangle and the ability to convert to a column
or slab hole or slab drop. After drawing a closed shape line = Select it = Right-click = Convert to
Column or Slab Hole/drop.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’



B PrroTa g 35

Views Creation

The graphical editor supports multiple windows; this allows you to create different views in separate
windows. The Views tab commands can be used to create new views and to arrange the views.

Loading Review Analysis Design Drawings & Reports BIM Display Views Help
= I = r I & -4
P 0| = P 1\
Reset Tile Horizontal Tile Vertical Smart Plan | 3D Physical| 3D Rebar
Model Model
Window Create View

> Goto Viewstab = Click 3D Physical Model '~

This command will create a 3D physical model view.
» Click Tile Vertically =2 This will tile the plan and 3D view side by side

cer ‘Rad

4 H structure
» o s
4T Views
T Storey: 1 (Plan)
To) Storey: 1(30)
i Reports
(53 Detad Previews
4 [ Storeys
» O St:0(+-0.00m)
4 © SE1(+3.00m) 4 H * ok
» | Cokmns :
» | shearwals R
» (7 Beams
» 7 Siabs
o/ Ribbed Siebs
b siab Strips I I
g Doses i #* i i+
<o Trusses
| sraces
LL Purins.
Rors [ | \
/ Frame Members // \
- I A\
Claddings 3

1 Planes

I
1
-

You can select & modify existing members or insert new members in the 3D view the same way as the
plan view.

Note: Alternatively, you can right-click on Views in the Structure Tree or header field of the existing view

tabs to create new views.

4 F structure Tile Horizontal
=1 Axis = ——
e / - Smart
| Storey: 1(Pla (®/ Plan % Plan
k=y Reports TSa) 3D Physical Model £ fD Physical Model
Detail Previews @ Analytical Model : ;D Rebarltnnda
4 F€ Storeys onnectivity View

Select the curve beam in the 3D view. Notice the same member will be selected in the plan view.
Right-click (to access the context menu) = Properties

Change the depth of the beam h-bot to 600 mm (as curve beam longer than rest of the beams)

YV V V V

Click Update and Close the beam properties
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Inserting Storeys & Defining Building Parameters

The final model will be a four-story building. We will now insert the other floors.

» Go to Building Setout = Storeys Operations dropdown = Insert Storey.

» Alternatively, right-click on Storey and pick Insert Storey

€ Select Storey 4 g(' =
» © St: 0 ( +0.00m) E Select Storey

= T Insert Storey

» © St:1(+3.00m) |[E* Add New Storey

: 7 Remove Storey Eﬁ Generate StOFE‘(J

& X Delete Storey BX Delete Members in Storey
, v Vi
4 (j Generate Storey E Remove Sto rey

B“ Edit Storey

-if 4
— Edit Storey

» Input Storey No : =4 2 OK

Add Storey

Storey No.: 4 Inserted Storey Height:

Add Intermediate Storey

Generate Members from Selected Storey

» When prompted to confirm = Pick Yes

3000 mm
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This automatically inserts stories 2, 3 & 4 with default height 3m. We will now edit the information

of the stories.

» Pick Edit Storey from the same Storey dropdown menu to enter the Edit Storey dialog

» Hold CTRL key and multiple select Storey 1, 2 & 3. Then click “Define selected stories as similar.”

Edit Storey
h Level D1 D2
|
Info | Storey (rom) {mim) Label || Description (mm) (mm)
d 3 3000 3000 G 15000 15000
2 3000 6000 2 15000 15000
» 3 3000 9000 3 15000 15000
4 3000 12000 R 15000 15000
Imposed LoadReduction Similar Storey
Apply i | Define Selected Storeys as Similar |
Reset Reset

Assume Roof as Normal Storey

Storey Label that defined this floor level,

walll
(m2)
0.00
0.00
0.00
0.00

Wall2
(m2)

0.00
0.00
0.00
0.00

Effective Top Storey No: |4

No.of Rigid Basements:

Imp. Load
Reduction

0.00
0.00
0.00
0.00

v 1st Storey Bottom Level:

Structural
System

RC
RC
RC
RC

Foundation Depth:
Footing Label:

Footing Description:

a

Help F1

ProtaStructure” ProtaSteel ProtaDetails’

ProtaBIM"
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2,3
1,3
2,1

v
oK

0 mm

1100 mm

X

Cancel
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Storeys 1, 2 & 3 will now be identical. Since we have already inserted members in story 1, these
members will be automatically copied to stories 2 and 3. In addition, changes to a particular similar level
will be applied automatically to all similar stories.

For storeys to be identical, they must also have the same storey height. In an actual project, STO1 is the

ground floor & will have a shorter storey height & hence should not be made similar.

» Change the member label under the Labels column as shown above, e.g., “G” for STO1 and “R” for
ST04.

STO1 members will be labelled GB1, GC1, etc.

» Click OK to exit and notice that the 3D view shows storey 1, 2 & 3 with identical members.

Storey 4 (Roof) has no members, so that we will generate (copy) members to this storey.

» Pick Generate Storey from the same Storey dropdown

L%.%_:-_f-;; €l _ _

| Source Storey: Target Storey:
0 Storey: 1 (+3.00m) 4= x Storey: 1 (+3.00m)
‘ o Storey: 2 (+6.00m) o Storey: 2 (+6.00m)
o Storey: 3 (+9.00m) o Storey: 3 (+9.00m)
Storey: 4 (+12.00m) Storey: 4 (+12.00m) <4

Member Type to be Generated

v Columns | Slab Openings /| Braces
v Shearwalls /| Slab Strips v Girts
v Beams /| Model Lines | Purlins

Under Source Storey, pick Storey 1 & then select Storey 4 as Target Storey

Click OK, and members will be copied from the ground floor to the roof

Click Close and check that members are indeed created in storey 4

Switch to show storey 4 in the plan view by double-clicking on storey 4 in the structure tree
Create a new slab with the same properties over the lift core since this is the roof level
Press ESC to deselect all previously selected members

Right-click anywhere on the plan view to expose the context menu

YV V V V V V VYV VY

Select Member Tables — Slab Table

The slab table allows you to view & change the parameters of the slabs in a group

bt Measure
E Member Tables b || =  Axis Table

F_:v Arrange All Steel Bars » | = Column Table
2 Wall Table

= Beam Table

B Siab Table 4EE

2 Ribbed Slab Table

» Click on the header q (live load), and the entire columns will be highlighted

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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» Click the Column-wise Edit icon at the top Fi{

> Enter 0.75 kN/m? = press ENTER (all the slabs live load values will be changed)

> Close the Slab Table

Slab Table

All Storeys
Slab Type

4 Storey: 4
RS3
RS54
RS5
RS6
RS7
RS8
RS9
RS10
RS11

bk |k | peh | g |k | gk | ek | e [

Member

h

(mm)

200
200
200
200
200
200
200
200
200

g-self
(k N/m2)

5.00
5.00
5.00
5.00
5.00
5.00
5.00
5.00
5.00

Wall Loads Library

You can set up pre-defined wall loads and then apply them using a dropdown list when adding the wall

loads.

Search H-; X Close

Additional Dead Loads

Enter Value...
Enter Value...
Enter Value...
Enter Value...
Enter Value...
Enter Value...
Enter Value...
Enter Value...

Enter Value...

g-Dead
(kMN/m2)

1.20
1.20
1.20
1.20
1.20
1.20
1.20
1.20
1.20

q
(k N/m2)

3.00
3.00
3.00
3.00
3.00
3.00
3.00
3.00
3.00

» Go to Building Setout > Libraries = Partition Wall Loads ﬁ’

Page - 38

Concrete Cover Angle Label Vertex Do Na
(mm) (Dearee)
30 0.00 0: Center
q (kN/m2)
0.75
v X
oK Cancel

Beam Wall Loads Library

Load Name

100 Brick Wall - Malaysia
200 Brick Wall - Malaysia
100 Brick Wall - Singapore
200 Brick Wall - Singapore
300 Brick Wall

External Wall

140 Block wall

100 Block Wall

ORRROO0N¢§

* || x Duplicate

Layer Name

Brick.

Unit Weight (kN/m3) Layer Thickness (mm) Load Value (kN/m2) _
v 20.00 130 260 ‘ ,
o

Total Load (kN/m2):

(1]

@  EdtReferences...

R —

2.60 ®

Edit Materials. ..

Cancel

Defaults wall types are automatically set up, but you can add any new user-defined wall type.

» Choose Cancel to exit

We will now insert brick wall loading on the beams in STO1.

>
>

Make the plan view active by clicking on it

Double click on STO1 in the structure tree to make it active

Select the bottom-left most perimeter beam along with Grid A/ 1-2

Click Edit Loads I'1" in the Beam tab that appears.

ProtaStructure” ProtaSteel
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Member Load Editor

The load editor of the beam will appear once the load cases and combinations are generated.

N e @ 1 - & x

N

]

Ju ]
[@

N

H

i U.I .
@

60! 5000
Load Properties 3 =0
AN

1,128 3,125 ET
Decomposed from: GS6 ( Slab .,

GB1 (5000 mm)

GE: mm , Ank: KN-m , Disp: m

=

N

w

>

U

)]

Load Types
e C(lick to choose the load type to insert, e.g., point load, full uniform load.
o Self-weight & decomposed slab loads are auto-calculated & cannot be edited.

. Load Case & Loads Folder & Load Properties

e Choose the load case to insert the loads. Existing loads will be listed for the selected load cases.
e C(lick on the load name to select it > Right-click will expose menu options to Edit, Cut, Copy or
Remove the load.

. Load Properties

e Enter Label, Direction & Magnitude values for the load to be created.

e Selectitinthe Loads Folder or Loads diagram > Revise values > Click Update to update an existing
load.

Loads Diagram

e |t displays the graphical representation of the loads, including self-weight & slab loads calculated
on beams.

e Existing loads can be selected by left-clicking on the diagram > Right-clicking will expose menu
options to Edit, Cut, Copy or Remove the load.

e Click on the beam diagram to insert a load after choosing the Load Type & input values in the
Load Properties.

e The load coordinate system is shown with X, Y, Z arrows. The beam & loads diagram can be
rotated by right-clicking & drag.

. Load Type filter

e C(lick the Load type icon to toggle on and off the associated diagrams.

. View Options & Shortcuts
Load Types View Options
&> Solid View Q 17 L PointLoad '.;’ [N & (y % Load Labels LabelTextHeight 10(3
£ Analytic View & A" Line Load & Magnitude Labels  Magnitude Text Height 0]
Transparency | Show loads Show Infill Wal Auto Scale Frame FrameEnd =
@) Orthogonal as merged | fair Areaload |oad as Line Load Labels Labels Distancelabels  Distance Text Height 109

Common Display Scale Labels

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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e These settings control the rendering of the member, loads graphics, text height, scaling & frame

labels.

e Show Loads as merged "+ Loads under the same load case will be combined in a single diagram.

This option must be switched off to edit or remove the load.

.
e Show Infill Wall as link Load © " If “on” infill wall will be shown as line usual line loads. The infill

wall will be rendered with actual height and width if the setting is turned off.

Let us insert a 100 mm preset brick wall load on this beam :

>

>

Trapezodisdl WallLoad | Fartisl Delete  Report  Zoon
Lo wal Lo s

Edit Openings 100 Brick Wall - Singapore

A=
e .h( =1l AR

GB1 (5000 mm)

Update

Pick Wall Load E{ﬂ under Load Types ribbon.
Notice only the wall load type layer will be active, and all other load types will be switched off
Ensure G load case is selected in the Loads Folder at the left.

In the Load Properties, Wall Load Library, pick 100 Brick Wall - Singapore. Note wall height is preset
to 3000mm = storey height.

Place the mouse cursor on the beam & left click to create the load.

The load will be created and added in the diagram & loads folder.

>

Press the ESC key to finish the wall load insertion process. Click OK to save & exit.

Wall Opening, e.g. of windows & doors can be inserted by clicking “Edit Openings”.

[+

Partial wall can be entered by clicking on Partial Wall Load icon

The brick wall load will be rendered in 2D and 3D views. Notice wall load is also copied to a similar storey
as expected.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Storey Load Editor

Loads can also be entered for the entire storey, instead of a single member :

» Ensure STO1 is active & no members are selected (press ESC key)

» Go to Loading tab > Pick Load Editor Storey: 1

Building Setout Modeling Loading Review Analysis Design Drawings & Reports BIM Display Views
HJ. 123 D = —
H( (Al m B @ S = o
Load Cases and | Load Editor Wind and Non-Structural Partiton  Slab Additional Slab Load Load Decomposition
Combinations Storey: 1 Storey Loads Component Loads Wall Loads Loads Calculation Method ~ by FE
LateralLoads Load Libraries Slab Loads

The storey load editor is similar to the member’s load editor, except that all the members & loads on
the active storey are shown. The differences are described below.

wh e - 1 - 8 x
L ) 2 & v X
- \ | =
7 l
b i
% w
=, )
= I
Load Properties =
pa- &
- i
7 x
- -
N,

1. Load Types
e Surface Loads are loads are area loads that can be applied to slabs and walls
e Self-weight is auto-calculated & cannot be edited.
2. Load Case & Loads Folder
e Choose the load case to insert the loads. Existing loads will be listed for the selected load case.
e Loads folder resembles the Structure Tree, which organizes loads under member type
e Show only Loaded Members: If checked, will omit any members without any loads from listed.
e Expand the folder > Click on the load name to select it > Right-click will expose menu options to
Edit, Cut, Copy or Remove the load.
3. Member Filter
e Toggle visibility of member type in the diagram. For example, if the Beam layer is off, then all
beams & loads applied to beams will be hidden.

We will now copy the brick wall load to all the perimeter beams.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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WwNe s s Storey: 1(+3.00m, Sim:2,3) m - 0 x
Load Types View Options
B B memalLoad (Batd Al /™ Trapezodial Load ¥} Polygon Uniform Area Load
l & l o ow x
== |py Sol Load 4 B8 wal Load @ wal Area Load
Point  Ful Uniform Partial _ Point  Uniform WallLoad  Full Uniform Rectangular Delete
¥’} Column Nodal Loads Table  .0ad load  Uniformload ok PartalWalload  Load  Load Areaload Uniform Areaload 4 Variable Surface Load Loads -
Frame Loads Surface Loads ~
Load Properties
= =
Label | 100 Brick wal - Singay ? L
Wall Load Library | 100 Brick Wal v g[] ﬂ
Edit Openings ?
Wal Unit Weight 00 im2
=
[z ¥ -
_T I T = gpy
h
SE==HN o 1
She
h-Start 3000 mm ﬁ?; ‘_E_,
o pr—
h-End 3000 mm = =
hness o
=
LI L]
i)
=, "
| g
A
= »,
AT y[ﬂ
— .

In View Options : Show Loads as merged is by default deactivated, so that the wall loads are shown
separately. Show Infill Wall load as Line Load is by default activated, so wall load is shown as line
load, instead of drawn to actual wall height.

» Choose G load case in Loads Folder.

» In Member Filter, toggle off the Slabs layer, so the slab and slab area loads are turned off.
=
» In Load Type Filter, toggle off Line Loads % & Decomposed Line Loads A@. to isolate the wall

loads

Select the partition wall load in the diagram > Right-click > Copy
Multiple select all the perimeter beams by holding down the CTRL while selecting the beams.

Right-click > Paste > Check the same wall load is pasted correctly.

YV V VY V

Go to Load Types tab > Click OK to exit the dialog.

» Examine the 2D & 3D views to ensure all wall loads are inserted correctly.

Alternatively, wall loads can also be copied in the plan view by the following steps :

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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» Select beam with wall load inserted

» Right-click > Copy Loads > Select the brick wall load > OK

Li,] Copy Loads = O X
G(1) Point Load (0) 100 Brick Wall - Singapore
Area Load (0)
Line Load (0)

Thermal Load (0)
Wall Load (1)
Soil Load (0)

Select\Deselect All

Cancel

4

The load case & load type panes act as filters for selecting the load name on the right pane.

» Multiple select the perimeter beams where loads are to be pasted (holding CTRL key)
» Right-click > Paste Loads

Similar steps can be used to delete loads by selecting beams > Right-click > Delete Loads.

Defining Slab Load via Load Editor

You will learn how to insert slab line load.
» Double Click on the Storey 4 in the structure tree (to make Storey 4 active).
» Select the bottom left-most slab, RS1 > Click Edit Loads

A slab load Editor will appear. It is similar to beam load editor but with additional surface loads type.

WY& - Slab: RS1-Loads H - 0o x
Load Types View Options

& Lfd m = W o4 x =@ & v X

Point || Uniform | wall Load  Full Uniform Rectangular Polygon Uniform  Variable Delete  Report ~ Zoom Extents OK  Cancel
Load Load a Loa a3 Load oads

Areaload  Uniform Area Loa Surfaceload L

Surface Loads

— %
. G Top
it G Load =
fatt Self Weight End Pt JX
#e3 S
P
< {827 Jaos2) L
et Q Load | ‘
Load Properties |g ‘
Label |G-3
Measurement Type  |Percent t v = Is((
Magnitude (Start) 5,000 kijm L h?
Magnitude s) 5.000 kiN/m |g §

Start Pt

\ @
&

P
4

(852, 809)

G-3
— local Axis L» \

Undate

» Go to Loading Types tab > Click Uniform load fffl
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Note all other load type layers will automatically switch off for clarity.
» In the 3D orientation cube, click on Top E > view direction will change to top
» Ensure G load case is selected
» For Magnitude (Start) & (End) > Enter 5 kN/m
» Pick the Start point on the load > Pick the End point (approximately vertical)
The line load will be created with a default magnitude. To edit the load :
wNe & - Slab: RS1 - Loads B - O %
Load Types View Options
L1 d dowm w8 s g xE= & vX
Thermal Point  Uniform WallLoad Full Uniform Rectangular Polygon Uniform Variable Delete Report Zoom Extents OK Cancel
Load Load Areaload  Uniform AreaLoad Area Load Surface Load Loads
Surface Loads -~
G vV &= = ﬁ . —
oads ~ G = ;—_éb
= : @ E
e
Load Properties Jl
Label |G-3
Direction Gravity =
| measurem ent Type | Distance M|
Magnitude (Start) 5,000 kNjm =
Magnitude (End) 5.000 kN/m éwl
v Insertion Tikt
X Y
Start Position 1000 mm 1000 mm %
End Position 1000 mm 4000 mm
‘\ G;_l\!C-CO . 1000)
< 7
Edit via Text v z 4

» Press the ESC key to end the line load creation mode.

» Select the line load name in the load folder or the 3D diagram (rotate the view to suit).

» For Measurement Type > Choose Distance

GE:mm , Anl: kN-m , Disp:m .

The Insertion inputs will show the location & magnitude of the load in table. The X & Y inputs are with

reference to the slab origin marked by a big dot.
» Change the values as shown above > Click Update > OK to exit the dialog

The line load will also be shown in the model plan & 3D view.

- B

REM 2506500

82

RS2, 3
200 i
4

RCY RC2
===~ == g

To edit the slab load, you can select the load in plan or 3D view, Right-click > Properties.
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Defining Slab Load (via plan view)

Slab loads can also be defined on the plan view of modelling.
(
» Go to Loading tab > Click the Point, Line, and Area Loads icon -ll

The slab load properties will appear as shown below.

Sib Load “ > Select the Line Load icon "
A ||| I+ » Define Angle = 90 degree, length of line load, b1 = 2000 mm and Load
Ange: 90.0° values at start and end, wl = w2 =5 kN/m.
wal bi:| 2000 mm > Pick the intersection of axes A/1 (reference point)
et Lond Mool : » Press F2 to define the relative coordinates. Enter “2500,2500” which
G-LoadMagnitudes:
[mt:,ﬁ | EEEE means AX = 2500 mm & AY = 2500 mm as shown below
(AtEnd) w2: 5.0 kM/m

Q-Load Magnitudes:

(At Start) wi: 0.0 kN/m

(AtEnd) w2: 0.0 kN/m
2500,2500 | @

[

Alternatively, you click on 2 points to define the start & end of the line load (without specifying Angle &
bl)

You can insert a partition wall load by clicking on the dropdown menu under “Wall” and select from the
preset wall types library

» Press ENTER & the slab line load will be created.

RC4

B e e :
\

% RS2 %

b 200 b

- RC1

LA B — —— miwan— —— " BT
\ /

» Delete this line load by selecting it > press the DELETE key

You may use the external reference drawing to display the architectural drawing at the back of your
model as a guide for creation of members or slab load.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Slab Opening Creation

You will learn how to define the coordinates and size of the Slab Opening.

» In STO4, zoom to slab between GL A-B/2-3.

&
> Click the Slab Opening/Drop icon = in the Modelling tab, and the slab opening properties
dialog box will appear as the figure below.

Slab Opening X
» Define the slab opening horizontal length, b1 = 1000 mm & vertical
Width, b2 = 500 mm. b1 1000 mm
> Pick the intersection of axes A/2 as the reference point of insertion = e
» Press F2 to define the relative coordinates Type: |Rectangular v
Angle

» Enter 1000,1000 which means AX = 1000 mm & AY=1000 mm in the
textbox as shown below

Drop Region Definition

« Update X Close

» Click Close in the Slab Opening Properties dialog box

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Member Re-labelling for Entire Building

The members are labelled automatically in the sequence they are created.

> To re-label the members systematically, go to Review Tab > Re-label Members

Member Re-labelling Options

Members Sort Reference
Columns and Slabs
v| Columns I V| Retain Compatible Labels Between Storeys I
Left-Top --> Right-Bot Right-Top --> Left-Bot
V| Shearwalls Member Number Start Value: 1
- ® Left-Bot —> Right-Top Right-Bot —> Left-Top
V| Beams
V| Slabs Walls and Beams Modify Prefix Character
HorizontalMembers
v/ Ribbed Slabs
Left-Top --> Right-Bot Right-Top --> Left-Bot
- @) Left-Bot --> Right-Top Right-Bot --> Left-Top

Vertical Members

Left-Top --> Right-Bot Right-Top --> Left-Bot

- () :;gﬁ—Bot --> Right-Top: Right-Bot --> Left-Top
Modify the Postfix

Reference Angle: 0.0°

v Group Cantilever Slabs Seperately

%]

toreys
v Group Members by Direction
First Storey:

Last Storey: @) Sort Rowwise

Sort Columnwise
v All Storeys

v X

OK Cancel

» Select all Members type
» Change all Sort Reference to Let-Bot --> Right-Top.

This means that the left-bottommost member will start with number 1.
» Tick Retain Compatible Labels Between Storeys.

This setting forces the members at the same position to have the same label across all storeys (e.g.,
1C1, 2C1, 3C1 will be at the exact location).

» Click OK.

The members will now be re-labelled systematically with label 1, starting with the left bottom-most
member.

It is common practice to have vertical member (column & wall) retain the same labels between
storeys, whereas this may not be preferred for horizontal member (beam & slab). To achieve this,
you can run the re-labelling twice for different member types with Retain Compatible Labels checked
& then unchecked.

The model is now completed, and we are ready to run the analysis.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Building Analysis

Page - 48

» Go to the Analysis tab —>click Building Analysis : — Pre-Analysis tab

Building Analysis

Unit Weight of Member:
Unit Weight of Blocks:
Coeff.of Thermal Expansion:

Codes:
Eurocode 2 (5G), Eurocode 3 (5G), Eurocode 1 (5G)

Edit Materials

25.00 kM/m3 (Column, Default)
4.41 kiN/m3
0.00005 1f°C

Building Model will be merged with the FE Foundation Model when Building Analysis is repeated.

a

Help F1

Pre-Analysis Model Options Analysis Post-Analysis Reports
Project Parameters and Loading
trr) -
& H £
Loading Wind and Storey
Settings Center CaTarin Load
Materials (Default)
Material Reinforcement Steel Grades
Columns C30/37 Grade 500 (Type 2)
Shearwalls C30/37 Grade 500 (Type 2)
Longitudinal Web Steel Grade 500 (Type 2)
Horizontal Web Steel Grade 500 (Type 2)
Beams C30/37 Grade 500 (Type 2)
Slabs C30/37 Grade 500 (Type 2)
Ribbed Slabs C30/37 Grade 500 (Type 2)
Foundations C30/37 Grade 500 (Type 2)
Links Grade 500 (Type 2)

Close

The Pre-Analysis setting is where the main assumptions of the analysis can be defined :

e Settings Centre: Access settings centre to review & modify analysis parameters such as the
design code and notional horizontal load.

e Load Combination: generate, add or modify any load case or load combination sets.

e Wind and Storey Load: automatically generate wind loads, review & input any lateral load.

Automatically generated lateral loads such as the notional horizontal loads will only be
calculated and shown after the analysis.
e Edit Materials: review, add, or change the concrete and steel material of the building.
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Materials
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We will now define the materials for this project via Building analysis> Pre-Analysis dialog.

> Pick Edit Materials

‘o Material

Default Materials
Foundation Floor

Storey Having Different &
Material

x

Concrete Columns

Concrete Walls

[

Longitudinal Web Bar
Horizontal Web Bar

Concrete Beams

Slabs

Rib

Links

Steel Columns

Steel Beams

Truss Members

Purlin Members

Girt Members

Brace Members

Frame Members

Grade 500 (Tvpe 2)
Grade 500 (Type 2)
Grade 500 (Type 2)
Grade 500 (Type 2)
Grade 500 (Tvpe 2)
Grade 500 (Type 2)
Grade 500 (Type 2)
Grade 500 (Type 2)

¥ OK K cancal

The materials and reinforcement steel grades are shown for all member types. Default Material is used
for super-structure floors. A separate Foundation Floor category is automatically created for foundation

members only.

If a different material is required for a particular storey, a separate material set can be added by picking

the *

icon. Steel reinforcement grades and diameters are also defined here.

» Pick Column Concrete Grade - select C30/37 — Apply to all members in this storey - OK.

Concrete

Concrete
C16/20
C20/25
C25/30
C28/35
C30/37
C32/40
C35/45
C40/50
C50/60
C60/75

% || X

General
Material Name
Material Color
Mechanical Properties
Modulus of Elasticity
Shear Modulus
Poisson's Ratio
Thermal Expansion Coeff.
Unit Weight
Design Parameters
Characteristic Compressive Strength (Fck)
Characteristic Tensile Strength (Fctk)
Material Coeff
Time Dependent Properties
Time Model
Compressive Strength and Stiffness
Creep
Shrinkage

I /| Apply to all members of this material dass in this storey, |

: C30/37

192, 192, 192 v

33000.0 N/mm2
13750.0 N/mm2
0.20

¢ 0.00005000 (1/°C)
;25000 kNjm3

: 30.00 Njmm2

1.92 N/mm2

: 150

: CEBFIB 90

: 0.000

: 0,000

: 0.000

¢ H cancel

» Pick Steel Grade and ensure that Grade 500 (Type 2) is selected and applied to all member types.
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Rebar

Rebar

Grade 250 (Plain)
Grade 410 (Type 2)
Grade 460 (Plain)
Grade 460 (Type 1)
Grade 460 (Type 2)
Grade 500 (Type 2)
SBPDN 930/1080
SEPDN 1080/1230
SBPDN 1275/1420

& | X

General
Material Name
Material Color

Mechanical Properties
Modulus of Elasticity
Shear Modulus
Poisson's Ratio
Thermal Expansion Coeff.
Unit Weight

Steel Bar Parameters
Minimum Yield Strength
Ultimate Strength (Fu)
Bearing Strength
Material Coeff
Rebar Symbol
Rib Type
Hook

Prestressed

t Type2

Page - 50

:  Grade 500 (Type 2)

I 255, 0,0

: 200000.0 Nfmm2

76923,0 Njmm2

: 0.30
+ 0.00001200 (1/°C)
: 78.000 kNfm3

500.00 N/mm2
550.00 N/mm2

¢ 0.00 Njmm2

1,15

: H

Rebar Diameters

¢ Edit... I

I v ;Qr.p!y to all members of this material dass in this slnrayi

¥ oK ¥ cancel

» Click “Edit...” next to Rebar Diameter & the rebar table will appear

Grade 500 (Type 2) Rebar Table

Column
wall
Beam
Slab
Rib Slab
Footing
Links
Longitudinal Web Bar
Horizontal Web Bar
Generic

KIS

Show All

Unit: Metric

&

Label Diameter (mm)

10 10.0
13 13.0
16 16.0
20 20.0
25 25.0
32 32.0
Fa

D

Area (mm2)
78.54
132.732
201.062
314.159
490.874
804,248

|
Y

<R KRR
KK KKK S
R R K
RIKIKIREQ
R R K
< KR RBy
KKK K e

v oK

In left hand Filter pane, tick Column, Wall, Beam & Slab to hide diameters of other members

all other elements, at least 1 rebar must be ticked.

Load Combinations

Click OK to close Rebar Table > Click OK to close Rebar dialog > OK to close Materials dialog.

We have already generated the cases and load combinations previously, as shown below.

X Cancel

A

Tick the diameters of bars to be used in the design of those members as shown above. Generic is for

No | Combination LLRed| R/C | Steel G Q Qpil Qp12 Qp21 Qp22 Qp31 Qp32 Qp4l Qp42 NGx NQx NGy NQy
1 G+Q v v v 135 1.50 L] 0 ] 0 0 0 0 0 0 0 0 0
2 G+Qp1 v 4 v 1.35 1] 1.50 0 0 0 0 0 1] 0 0 0 0 0
3 G+Qp2 v v ' 135 o] 0 0 1.50 0 0 0 0 0 0 0 0 [}
4 G+Qp3 v v L 135 0 0 0 0 0 150 0 0 0 0 0 0 [}
5 G+Qp4 v v v 1.35 0 0 0 0 0 0 0 1.50 0 0 0 0 0
6 G+Q+Nx v v 4 1.35 150 0 0 0 0 0 0 0 0 1.00 1.00 0 0
7 GHNx+Q v 4 0d 135 L05 [} 0 [} 0 [} 0 0 0 100 1.00 0 [}
8 G+Q-Nx v Cd Cd 135 1.50 0 0 0 0 0 0 0 0 -1.00 -1.00 0 0
9 G-hx+Q v v 0 1.35 1.05 0 0 0 0 0 0 0 0 -L00 -L00 0 0
10 G+Q+Ny v v v 135 150 0 0 [} 0 [} 0 0 0 0 0 1.00 1.00
11 GHNy+Q v 4 Cd 135 105 0 0 0 0 0 0 0 0 0 0 100 1.00
12 G+Q-Ny 4 Cd Cd 135 1.50 0 0 0 0 0 0 0 0 0 0 -1.00 -1.00
13 GNy+Q v v v 1.35 1.05 L] 0 1] 0 0 0 0 0 0 0 -1.00 -1.00
ProtaStructure” ProtaSteel  ProtaDetails’ ProtaBIM’
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» Review & click OK to close the dialog.

Wind and Storey Loads

Page-51

Allow user to review & input lateral loads such as notional horizontal & wind loads. We will skip this for

NOow.

Wind load cases and combinations must be generated first. For more guidance, kindly refer to Prota

Help Centre : Wind and Storey Loads

Building Analysis Model Options

» Go to the Model Options > Model = Material & Section Effective Stiffness Factors and review the

stiffness factors as shown below.

Building Analysis
Pre-Analysis Model Options Analysis Post-Analysis Model Export Reports
Model Shearwall Model Slab Model Settings
I Material and Section Effective Stiffness Factors I Default Settings
Effective Material and Section Stiffness Factors
Elastidty Bending Torsional
|
Modulus Aoal Area Stiffness Shear Area Constant
Shearwalls (Shell) 1.00 1.00 In Plane 1.00 1.00 1.00
1.00 1.00 QOut of Plane 1.00 1.00 1.00
Shearwalls (Frame) 1.00 1.00 Major 1.00 1.00 1.00
1.00 1.00 Minor 1.00 1.00 1.00
Basement Walls 1.00 1.00 In Plane 1.00 1.00 1.00
1.00 1.00 Qut of Plane 1.00 1.00 1.00
Slabs 1.00 1.00 In Plane 1.00 1.00 1,00
1.00 1.00 QOut of Plane 1.00 1.00 1.00
Columns 1.00 1.00 1.00 1.00 1.00
Beams 1.00 1.00 1.00 1.00 0.01
Coupling Beams 1.00 1.00 1.00 1.00 1.00

section properties are used.

You can modify the elasticity modulus, section areas, moment of inertias and torsional constants of the member groups to be used in the analysis
model. For example, you can enter 0.05 to reduce the moment of inertia values by 95% to reduce the lateral stiffnesses of the columns.

Note: In order to apply these factors, building analysis must be repeated. These factors will be applicable only for load cases for which aracked

The stiffnesses table will only be applied for load cases with Used Cracked Sections checked in the
respective Load Case Editor, except for seismic load cases where cracked sections are always

assumed.

All factors can be modified, except those that are greyed out, which must be auto-calculated.

Building analysis must be repeated each time the effective stiffness factors are changed.

To prevent large torsional forces in primary beams due to secondary beams, the global Torsional
Stiffness Factor is by default set to 0.01 (1%) in the Stiffnesses settings.

Stiffnesses of individual members can be changed by selecting a member = Right-click = Edit

Section/Material = Properties tab.

ProtaStructure” ProtaSteel
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Running Analysis

» Go to the Analysis tab.

Page - 52

Before running the analysis, it’s always recommended to check the model’s validity.

» Click Building Model Check & pick All Storeys & click Start.

0§, Building Model Check -

/| Overlapping Slabs Check
7| Overlapping Columns Check

/| Overlapping Slabs with Beams and Walls Check

/| Columns Inside Slab Panels Check

v Overlapping Beams and Walls Check

/| valdity of Axis Intersections Check

/| Proximity of Axis Intersections Check

/| Overlapping Columns Spanning More Than One Storey Check
/| Columns and Walls with Zero Length Check

/ Repeating Member Labels Check

Check Overiaping Beams with Beams and Wals:

...Operation Completed.... Number of Errors= 0

Check Zero Clear Length Beams:

...Operation Completed.... Number of Errors= 0

Check Repeating Labels:

...Operation Completed.... Number of Errors= 0

Building Mode! Check Completed... Number of Errors= 0

Load Log to Editor l v Start

» Click Close to exit the check.

The building analysis can now be performed.

()

v All Storeys

¥ Close

X

Delete Orphan Corewal Panels

Buiding Analysis

Pre-Analysic | Model Options | Analysis | Post-Analyss | Reports

Building Analysisand Design

=% Building Model Check X | | Building Analysis

Analysis Type: Static Analysis

Analysis Date: - Invalid —

Perform Eigenvalue Analysis (i)

Display Analytical Model Before Analysis

| Refresh the Connectivity Information of All Members:

Save Foundation Column/Wall Results for Multi-block Combined Foundation Design

Axial Load Comparison Report

Codes: 3
Eurocode 2 (S6), Eurocode 3 (5G), Eurocode 1(SG) o
Help F1

Close

The building model check will pick up the most obvious
modelling errors as indicated.

The warnings / errors are mostly self-explanatory. The
exact member(s) affected will be stated.

You should review any warnings / errors and correct the
model before proceeding to perform analysis.

Click “Load Log to Editor” to open the list of
warnings/errors in a separate screen in Notepad for ease
of reference.

» Click Building Analysis
Eigenvalues analysis can be done to obtain the natural
frequencies and mode shapes of the structure.

The Batch Design Options dialog will appear. It allows you to
perform the design of column/wall and beams automatically
after the analysis. We suggest that this should only be done
if you are confident that the analysis result is correct.

» Check Column/Wall Reinforcement Design
» Check Beam Reinforcement Design
»  Pick Building Analysis to analyse & design the model

The analysis will also check for instability and large
deformations and there will warning messages if any are
found.

The Analysis Summary Report will appear at the end of the analysis, summarizing the essential results.

ProtaStructure’
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Axial Load Comparison Report

An important check on the validity of the analysis is the Axial Load Comparison Report. This report sums
all the dead and live load applied at each storey and displays the axial forces in the columns and shear
walls. These values need to agree within a tolerance limit of 5%. If they do not, the reason for the
discrepancy should be investigated.

» Select Axial Load Comparison Report (in the Analysis tab)

TOTAL LOADS (Based On Slabs Loads):

G - Dead Loads:
Storey Column Wall Beam Slab| Ribbed Slab Total
4 (+#12.00m) 9380 2531 27.39 1937 0.00 188028
3 (+2.00m) 9380 2951 75936 1035.9% 0.00 218443
2 (+6.00m) 9380 2951 75936 1035.9% 0.00 216443
1 (+3.00m) 9380 2951 759.36 1035.9% 0.00 218443
Total 3156

Q - Live Loads:
Storey Column Wall Beam Slab | Ribbed Slab Total
4 (+12 00m) 0.00 0.00 0.00 15547 0.00 15547
3 (+9.00m) 0.00 0.00 0.00 545 BB 0.00 546 B8
2 (+6.00m) 0.00 000 0.00 545 BB 0.00 546 86
1 (+3.00m) 0.00 0.00 0.00 54686 0.00 546,86
Total 1796.05

TOTAL LOADS (Decomposed to Beams):

G - Dead Loads:
Storey Column Wall Beam Slab| RibbedSlab Total
4 (+12 00m) 9380 50953 127783 000 0.00 1881.16
3 (+8.00m) 9380 40242 1689.09 000 0.00 218531
2 (+5.00m) 9380 40242 1689.09 000 0.00 2185.31
1 (+3.00m) 9380 40242 1689.09 000 0.00 218531
Total B437.10

Q - Live Loads:
Storey Column Wall Beam Slab| Ribbed Slab Total
4 (+12.00m) 0.00 28.13 127.34 000 0.00 15547
3 (+0.00m) 0.00 56.25 490 .61 0.00 0.00 54585
2 (+6.00m) 0.00 26.25 49051 000 0.00 4588
1 (+3.00m) 0.00 56.25 490 61 0.00 0.00 54686
Tofal 1796.03

BUILDING ANALYSIS COLUMN AND WALL AXIAL LOADS:

Storey G Delta G Q Delta @
4 (+12.00m) 1881.16 1881.16 155.47 15547
3 (+9.00m) 408648 28531 702.33 546 86
2 (+5.00m) 625179 2185.31 124919 545 85
1 (+3.00m) 8437.10 2185.31 1796.05 54686
Total B437.10 1796.05

Total Base Reactions: G=B4371kN Q=1795.06 kN

Table 1: TOTAL LOADS (Based on Slab) is the sum of dead and live loads of all members with the slab
load not yet decomposed or calculated on the beam. You can take this as the input weight of the
structure.

Table 2: TOTAL LOADS (Decomposition to Beams) consider the decomposition of the slab load onto the
beams based on either yield-line or FE Decomposition. The beam load now includes the slab loads (and
hence zero values are shown under the slab column).

Table 3: BUILDING ANALYSIS COLUMNS AND WALL AXIAL LOADS sums up the actual column and wall
axial loads after building analysis.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Firstly, check Table 1. Total values are similar to Table 2. This ensures that beams accurately capture all
slab loads, i.e., no lost slab loads.

Then verify Table 2 total values are similar to Table 3. This ensures that all the super-structure weight is
entirely captured by the columns and walls down to the foundation.

Analytical Model

The Analytical Model enables you to review the results of the analysis graphically. It is essential to check
& verify the analytical model to ensure the model the correctly set up & results are reasonable.

» Go to the Post-Analysis tab of the Building Analysis dialog.

» Click Display Analytical Model

Alternatively, go to Analysis tab > click Analytical Model icon.

A new Analytical Model tab set will appear with the Analytical Model view.

OB ke - e e 5 ot = nY Analytical Model
u ':u.:.«;:e: vodelng .:ei.« Anal D & Repor D .-.sda. - tep | General  Member s ll;o:.a-wrs w:‘:e‘p N r‘ibbon ta bs
W = . kvd ) : —_— esuit Coleftion Method
Dsplacements = Diagrams ) Diagrams eropernes
Displacements Diag sy os Det -
cer Qag rer: +
e . ~~ Xto close view | Load Combinations
+PSwuse ) — Load Cases f—y - wmicues
B e 1 e Filter functlons |‘|‘ /-/\ T g
0 Storey: 4 (30) [ ——
Y | "T @11
7 . — iz
St 2 F':: \". _ f““‘—,—’ // o
! |\ T—0_ AL J §
‘ v \.\ /\ P~ ~— T~ hes
A i~ = - / [ a1
A v \— \ = N o
: = |- T3~ o
v o
! 2 \ . Load o
: ¥ \< /\, Combinations [ | eicombestens
: \ T v G+Qp1
: oy P8 =
: \ \ . / | ‘ géﬁ
v \ \\( Tiv,_ ~— ; o
hd \\ . 1 1 4 - - / G4Q
: |\ Py [ / 1 ) 2::
W \\ \Kl_l L " Gty
it 7 G4
2 I | |
X

——=c ‘
The analytlcal wireframe is shown in blue. Load cases and combinations can be selected on the rlght—
side pane.

If too much information is displayed, the screen can appear cluttered. However, you can create a more
meaningful display view by using the various filter buttons and the view settings.

Max:0.024, Min:5.92126-05 m I | Ge: mm , Aci: iv-m , Disp: m

» In the General tab, click on the Filters command (if it’s not activated)
The filter options will appear on the left-hand side of the view. There are options to filter the display

by Storeys, Axes, and Member Type.

.____,)- @, zoom In B save Picture __,T-‘? b A
= - oYV - |(8H ¥H H
Q Zoom Out @.‘,‘] Copy Picture
Settings  Plan View Find Filter  Connectivity Linear Pushover Time History
&P Orthogonal Issues
Appearance Tools Analysis Result Type

The Find command allows you to find a particular Node, Frame, or Shell number.

Connectivity Issues lists all the frames with unsupported nodes and highlights them when selected.
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> Click the Members tab.
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This is where you can show node labels, rigid diaphragms, element labels, and beam loads.

A Local Axes
A Direction

Loads

b Ah

Frame Frame Load

A shellMo AL Thickness
&, shrink N Materials
A, Surfaces AT Pressures

A

Show Labels for
Selected Members Only

Shells
Labels

Shell Members

Click Frame Loads & Frame Load Labels icons to show loads calculated or decomposed on the beams

This may include all the slab loads, brick wall loads, beam self-weight & other manual input loads.

Click Diaphragms -2 Select All will show the rigid diaphragm formed by the slabs (& then turn it off).

The grey lines join nodes constrained by the diaphragm to the centre of the diaphragm mass.

® N1 : Loads ™ / :2/ V Frame Mo ‘,’ Rigid Members
SN @ £ supports = IF Sections | ;4 Hinges
Nodes Labels Diaphragms  Frames  Labels .
_!__ Springs SG Materials o Shrink
Nodes Frame Members
(& then turn it off).
» Click on the Results tab.
P Animation ef»e Auto Scale [_x ] R @
E I ‘F’ Bi-directional Animation Scale I_Y' E
Displacements z
s Cubic Curve I_Z. IL. @ Nodes

Displacements

J\ shel Members
/ Frame Members

V2
Diagrams

Properties

Diagrams Details

» Click Displacement =2 The red lines show the structure’s displacement (deflection).

By default, Auto Scale is activated. You can deactivate this and then type in your Scale.

Displacement Unit can be changed in the Settings Centre > Units and Format

Click on the various directional displacement values by selecting x, y, z & R (Resultant). Rx, Ry, Rz is
the rotation of joints in radians.

The Maximum and Minimum displacement is shown at the bottom of the screen.

2 - Building Analysis Model X

O=2.99700C-U%
e T g
L e B=4.9621E-04— l

B=6.8643E-04

B=9 4099E-04
iy

Click on this legend = an arrow will appear to pinpoint the node of maximum displacement.

I | Deflections shown

in red lines

Displacement [Resultant] - (G) - Max:0.011, Min:2.4312E-04 m

ProtaStructure’

Click Animation to visualize the deformation of the structure.

Click on this legend to
locate max displacement

Switch off the Displacements display and click on the Diagrams button.
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» Click on the Axial force N icon to display the Axial Force diagram (for G Load Case).

1_Model Analytical Model

ks BIM Display Views Help General Members Results Contours Solid Model

N T igdlabels |l Columns Rigid Link
Z y2  Mpp  Auto Scale ji ShearWalls
Diagrams - =
vy Mg Scale 2.5 (7 Beams
Diagrams

3 - Building Analysis Model X

Diagrams Legend

N - Axial forces

V2 —Major shear force of beams and
walls. Shear of column along dir 1

V3 — Minor shear force of beams and
walls. Shear of column along dir 2

M2 — Minor moment of beams and
walls. Moment of column along dir 1

M3 — Major moment of beams and
walls. Moment of column along dir 2

T-Torsion

» Experiment with the various effects of the diagrams.

You can change the diagram scale by de-activating Auto Scale & typing the desired Scale.
You on/off the diagrams on Column, Shear walls, Beams & Rigid link by clicking on the respective icons.

» Click Properties icon reee & select a frame member will show the detailed member properties,
including material, section properties & summary of analysis forces at both members ends.

Frame: 216 Properties X
Frame No 216
Structural Member RE8 (Beam)
Nodes -

Rigid Zones
Restraints

Material Properties

AKIKIK]

'\
Section Properties
» I-Section
\ » J-Section
Temperature Difference v
Analysis Results () -
\ 4 1€nd

N - Axial Force 0.00 kN
V2 - Shear Force 2 -25.97kN
V3 - Shear Force 3 0.00 kN
T - Torsional Moment 0.00 kN.m
M22 - Bending Moment 0.00 kN.m

M33 - Bending Moment. -33.41kN.m

4 JEnd
N - Axial Force 0.00 kN

Contours tab will show contour results for shell elements which will only be visible if finite element
shell walls is assumed, or floor slabs are selected to be meshed in Building Analysis.
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> Go to the Solid Model tab.

This allows the various effects such as Axial Load & effects to be color-coded on the physical model.

Contours Solid Model

Review Analysis Design Drawings & Reports BIM Display Views Help

N T E I_z‘ / Frames
ve Mz Lx A, shels

V3 M3 I_Y.
Solid Model

3 - Building Analysis Model X

N
(kN)

-1472.16
-1349.48
-1226.80
-1104.12
-981.44
-858.76
-736.08
-613.40
-490.72
-368.04
-245.36
-122.68
0.00

| [ [PIRmn(ain |

f‘N
X

» Close the Analytical Model view by clicking on the “x” sign next to the view name.
» Alternatively, you can click to switch to plan view and exit the Analytical Model
interface.

You must interrogate the Analytical Model and check its validity as that is the actual analytical model
from which the design forces will be based.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Column & Wall Design

> Navigate to the Column Section Design under the Design tab.

The columns and walls are not designed as indicated by a red cross under Design Status header.

= B A4 o s Column Reinforcement Design - Project: Quick_Start_Guide_after_analysis A - [m| x
IB- Design Reports [.‘
L L N
5 % w % Y B Do
Interactive  Column Design Steel Settingsand  Filter Delete User Copy Bars é
Design (Batch Mode) Standardisation Parameters Defined Loads
Design Edit
0
Columns Storey (r:rln) (nk:ri) 2?;1‘3: unggaht:n Print Qty SS;DET[";S Steel Bars Links
> GC1 1 500 250 X o 0 0 A
2C1 2 500 250 X o |0 0 ]
3C1 3 500 250 X 0 0 0
RC1 4 500 250 X 0 0 ]
GC2 1 500 250 X 1] 0 0
2c2 2 500 250 x 1] 0 ]
3C2 3 500 250 X 0 0 0 v

&
> Click Column Design (Batch Mode) =

Column Reinforcement Design

Three design options are :

Storey Filter

Process Completed, Check Steel (Select New Steel When Previous Bars
are Insufficient) : Assuming there is previous design,
only change rebars that is insufficient. Bars that are
sufficient will not be changed at all.

Re-select Manually Edited Links

Check Steel (Don’t Select Steel When Previous Bars
Reinforcemnet Selection Options . . L.
Check Steel (Select New Steel When Previous Bars Are Insufficent) Are InSUfﬂCIent) : Freeze a” eXIStlng r-ebar-sl
Check Steel (Don't Select Steel When Previous Bars Are Insuffident) insufficient column will be marked as failed.

®) Re-select All Bars

Re-select All Bars : Discard all previous rebars and
i; o o X redesign all the beams with current beam design
[:Messages | 3 Close settin gs.

» Pick Re-select All Bars to design all columns.

Once batch design is completed, the “Message” icon will appear.
»  Click on Message icon to review the design summary.

If there are any failures, the exact beam & reason will be stated.
» Close the notepad & batch design dialog.

The design menu will be updated with pass status, UR = Utilisation Ratio and other steel bar information.

> Go to the Reports tab = Choose Design Report =

A tick in the Print column marks the columns included in the report. Columns can be added or removed
from the report by checking or unchecking the Print checkbox. Furthermore, icons Mark All Columns
and Remove Print Marks can be applied to all columns.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Column Design Results

ReportOptions

Indude All Load Combinations in the Report
Include Interaction Diagram in the Report

Display All Combinations in the Interaction Diagram

I | Include Column/Wall Sections in the Report I

Column Design Report Title:

Column and Wall Design Results Report can be prepared using this dialog.

The report will contain the members as filtered and sorted in the Column/Wall Design Table

L4 X

oK Cancel

» Check “Include Column/Wall Sections in the Report” to draw the column section detail.
You can also give the report a title.
» Pick OK to generate the report.

All reports can be exported in PDF, MS Word, image, or webpage (HTML) format.

Column Reinforcement Design - 0 x
. 10.00% v
=) Y O FitPage Q [110.00% (il Horizontal Ruer @ @ [ Toimage -
= la O At width @ zoomIn
Prnt 100% I Mitple Pages ), Zoom Out D Vertical Rules POF To ufﬁre [ Toweb -
Zoom Show Export
Notifications Ll =

Notifications = Headings . .
<::olumn Reinforcement Design

GC1 (A1) (500/250)

Materials: C30/37/ Grade 500 (Type 2) (Links: Geade 500 (Type 2))

Section
u w 9
S

Critical Loading: 1 - (G+Q)
Min__ Design

N 67408 - 674.04 kN
My 2068 1348 2351 kNm
Mz Hm 1348 3478 kNm

Nygy 303153

Concrete Cover = 35 mm

- Neutral Axds. 174 mm / 11.45¢

= Shear Rebars
. Vesia = 15.19/10.34 &N Slender Column. As (Req) 9%50.20 ey 250 m#
ves = 0.13/0.13 Nmm? | AdLims = 2632205 As(Sup) %064 796 e
- ViR = 1.04/1.15 Nimm? AdLimg = 116<205
Ve v = 5.70/570 Nimm? Mass 12 = A75/000 WNm 6H13
= Links = H10-250

-:c.umr.r::urfm-:cn:ml:c:ngn| rage: [l 11 ‘ i NoEmors (f MoWamings | Messages:0

» Exit & this report will automatically be saved & made available for compilation in Report Manager

The Interactive Column Design allows you to examine & alter individual column designs in more detail.

» Double click on GC1 in the list of columns in the Column Design screen.
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{ Section Dimension shows the
parameters of the column such as size,
clear height & concrete cover

= . Steel Bars shows the number and layout
| | : = | of the rebar. These can be changed.

e e ‘ v Load Combination table list down all the
e 50 e R load combination. The most critical
(governing) is highlighted in red.

662.51 20.69 32.00
675.16 -10.31 -13.18
615.34 2.53 2,33
628.00 10.23 10.60
662.13 2. 3169
67479 10.32 1314

Required & Supplied As are calculated
from the critical load combination.

614.59 2.53 2.34
627.25 -10.23 -10.43
661.05 20.70 315
67371 10.32 271
635.24 19.68 30.00
647.90 9.82 -12.08
66171 20,69 3182
6743 10.31 13.24

635.90 19.67 .23
648,55 481 -1260

660.42 20.69 3147

Slenderness tab shows the bracing
assumption, calculated effective lengths
: Sececec & additional moments.

If there are changes in the assumption of this column, you can click the Interactive Design button to re-
perform the reinforcement design.

You can change the dimensions (b1, b2) above & click Update. This is handy if a column fails due to
insufficient size & you want to try out if a bigger size works. However, due to the change in column size,
the weight & stiffness of the model will change. Hence, you should re-run the analysis and re-check the
column design to ensure it is sufficient finally.

» Click Column Analysis to inspect the Interaction Diagrams (capacity curves).

The Interaction Diagrams (N-M) show the possible combination of axial force and moment that cause
failure to a given column dimension and rebars. This “capacity curve” indicates the maximum axial
capacity of a reinforced column is dependent on the co-incident or applied moment (vice versa). The
axial capacity of the column decreases as the applied moment increases until the ‘Balance point’, i.e.,
the maximum theoretical moment capacity. After this point, moment capacity decreases with
decreasing applied axial load.

[ Interaction Diagrams - Colum: GC1 (Storey: 1) o x

INTERACTION DIAGRAM (N-M) - GCIN= 542.61 kN M22= 19.4 / M33= 28.5 kN.m > Se/ect Interaction Diagram (N_M)

(500/ 250 mm) 8H13

For rectangular columns, there will be 2
capacity curves in direction 1 and direction 2
respectively.

The governing design will be the direction with
load combinations closer to the curve; for this
column in will be along dir-2, the shorter
dimension & hence weaker capacity.

» Select Dir-2 (N-M22)

200 To verify that this column passes with the

600 rebar selected, all the design combination

' " . points must be within the curve, especially if
weses ezt | yoy have manually changed the rebars in

| Design Moments 3 = X

9 8 Comteators e . Rebar Table.

1200
Design Combinations
900 \

600 =
[ A
\ 7/

00 ~—-

N (k)

Balance Point \

Both

= interscion oy 0077 |

Tnteracbon Diagram (M22-M33) ‘Both Drections
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The Interaction Diagrams (M22-33) plots the component directional moment capacity of the column at
a given applied axial load.

» Close the Interaction Diagram and go to the Slenderness tab.

The Slenderness tab shows the bracing conditions of the column/wall, effective length factors &
additional moment (M-add) due to slenderness.

Steel Bars Links Shear Design Settings

Bracing

/| Dir-2; Braced

+’| Dir-3: Braced

Effective Length Factors

B-2:
B-3:

0.729

0.669

Bracing

Dir-2: Braced

Dir-3: Braced

Effective Length Factors

B-2: 1.792

B-3:

1,442

Edited

Slenderness
A2/AHimit2

A3/Adimit3

Edited

)

DESIGN REPORT
CRITICAL COMBINATION: #1 (G+Q)

Added Moment-22 = @.80 kN.m
Added Moment-33 = .88 kN.m|
N-Design = 524.46 kN

M22-Design = 19.55 kN.m
M33-Design = 28.74 kN.m

Edited

Slenderness
A2/A-imit2 1.229

A3/Aimit3

Edited

——>

DESIGN REPORT
CRITICAL COMBINATION: #13 (G+Q-Ny)

Added Moment-22 = 38.12 kN.m)
Added Moment-23 = 10.36 kN.m|
N-Design = 525.35 kN

M22-Design = 50.89 kN.m
M33-Design = 31.51 kN.m

For this column, it is braced in both directions, the
calculated effective lengths B are less than 1 & hence
M-add is zero or minimal.

You can change the bracing condition manually.
» Untick both Dir-1-Braced & Dir-2 Braced

» Click Interactive Design to refresh the design
>
>

Notice the unbraced condition of the column now
results in effective lengths > 1. As a result the additional
slenderness moment, ‘Added Moment’ is calculated
and auto-added to the base desigh moment to become
the final design moment.

Click Design Report for detail report
Go back to Slenderness tab to review

If you want to manually save either the Bracing or B
factors, ensure to tick “Edited”. This means the design
module will not auto-calculate these values anymore.

» Click Diagrams to view the shear force, bending moment, or deflection diagrams.

» Click Elevation Drawings to view the reinforcement of the column in elevation.

ProtaStructure’
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Manually Specifying Column Design Forces (for info)

The column design forces are automatically linked and updated to the latest analysis run. You can over-
write the column design forces manually.

To manually enter column design forces :
1. Select the first row of column design forces
T — To select more rows, hold down CTRL key

- 2. Pick Select Marked Combination as User Defined

om0 3. Click on figures under “N” axial load & enter
. figures for top and bottom, e.g. 1000,1000

S| 4. Pick Select / Unselect All to select all rows

5. Click Interactive Design to refresh the design

L e o 6. Untick User Defined Loads to auto-link back to
analysis forces.

Manually Change Column Reinforcement (for info)

The column design module will automatically design the column to pass status. However, there are
situations where you might want to specify the reinforcement manually & check if the column passes.

To manually fix the layout & number of rebars & let column design auto-select rebar size:

Column Design

B L% A0

Interactive Column [, ~.ms Save& Reset
DES\Q!‘I4 Analysis  Report Report  Bars

:EJ v X VY4 :
Parameters] Image Elevation OK Cancel 1. lnput 2 fOf 1'Int Undef ny CO/Umn

Max/Min  Drawing

Notice diagram now shows 2 nos. internal

Desgn Farameters swctme | e | shewvesgn | seniemess || NOTiZONtal bars on both sides
Design Method .
Defat (or Spacng osimation Methc) Sl | oy | Avesrom reanec| 2. Pick Parameters
Pos Area (mm2)
3 , = R
O ey Mestmbmton Metd g 1 : = 3. Pick Fixed Bar Layout Method = OK
<n 2 |y

r Size Minimisation Met
Bar Size Minimisation Method 24nt 0 1 0

This option ensures that the number of bars

Material

Concrete: C30/ -Fkm20.00 Njan2 - will not change during re-design
B | v | X pot = er 4. Click Interactive Design to re-design
Help oK Cancel - L )
Supplied As= 1062mm2 (%0.85) = As,min . .
The column will be re-designed to 8 number
C30/37 / Grade 500 (Type 2) N M1l M2 . . . i
No @) Nm)| G of bars as specified. If this reinforcement is
1-Top 664.74 20.69 31.69 . . . . .
5 II_I' ] . Bottom| 67740 032 1298 insufficient, the program will auto-increase
2 -Tof 665.87 20.69 31.99 .
Sotton| omss 031 38 the bar size, say from H13 to H16.
3 -Top 618.71 20.53 26.32

You can also manually change both the number of bars and rebar sizes (i.e., both Qty & Diameter). Do
not click on Interactive Design, which will change the rebar sizes. You must then manually check the
following to ensure the column passes:

» Check As Supplied is more than As required and Min Steel %

» Click Column Analysis = Check all design points are within the Interaction Diagrams N-M11 & N-M22

> Click Cancel to exit the Interactive Column Design dialog and Close the window.
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Beam Design

» Go to Design tab = pick Storey Beams U

Since we have selected beam reinforcement design as part of Building Analysis, all the beams are already
designed as indicated by green ticks.

ey @ - Storey Beam Section Design and Detailing - Project: Quick_Start_Guide _after_analysis B - 0 X%
Design | Grouping a
= aA = Li 4 E @ pasteE == = =" EEJ: = = (3 Mark All Design Axes
= =) - o = i= = L =] As .
¥ Mark Group Master Axes Only
Interactive | Beam Design| Diagram | Optimize Rebar Layers Settingsand  Fiter CopyBars (@ pastegarstmal |~ SUmmary Summary Detaled  Flange  Barlist Utization
Design | (Batch Mode)| (Multiayer Pattern) ~ Parameters  Axes Table Report Report Shear Check RatioTable (2 Remove PrintMarks
Design Edit Reports -
Group s Storey Part Beam Quantity Rebar Pattern Design U. Ratio Print | Beams
A 1 1 5 1 Bent-Up Pattern 1 x 0 GB1-GB2-GB3-GB18 - GB19 4l
B 1 1 3 1 Bent-Up Pattern 1 X 0 GB4-GW1-GBS
1 1 3 1 Bent-Up Pattern 1 X ] GB6 - GW2 -GB7
e1 1 1 1 1 Bent-Up Pattern 1 X o GBS
1 1 2 1 Bent-Up Pattern 1 X 0 GB9 -GB10 v

» Click Beam Design (Batch Mode)

The same 3 options of design which were presented for columns are shown.

» Pick Re-select All Bars to auto design all beams at one go with the current design settings.

» Pick OK when prompted if you want to use the current rebar pattern set in beam design settings.
» After completion of batch beam design, close the batch beam design dialog.

The beam design dialog will be updated showing pass status for all beams. A tick in the Print column
marks the beams included in the report. Beams can be added or removed from the report by checking
or unchecking the Print checkbox.

»  Choose Remove Print Marks to exclude all beams in the report.

»  Checkf/tick the checkbox under Print for the first-row beam axis A only.

Bav g - Storey Beam Section Design and Detailing - Project: QSG_r6_118 - 0 x
Grouping a
== =y == S7 m . == ) = :._Ug = =R (@ Mark All Design Axes
= = M 2] - 2 = E T 8 A&
A — ¥ Mark Group Master Axes Only
Interactive BeamDesign Diagram  Optimize Rebar Layers Settingsand  Fiter CopyBars [ Summary Summary Detaled Flange  Barlist Utiization
Design  (Batch Mode) (Multlayer Pattern)  Parameters  Axes Table  Report Report Shear Check RatoTable | Remove Print Marks
Design Edit Reports »
Group Axis Storey Part Beam Quantity Rebar Pattern Design U. Ratio Print Beams
A 1 1 5 1 Standard Pattern 2 v 0.88 GB1 - GB2 - GB3 - GB18 - GB19 )
B 1 1 3 1 Standard Pattern 2 v 0.93 GB4-GW1 -GBS

v

» Choose Summary Report

Summary Report

The Beam Design Report is in rich text format.

Report Options

Print Beam Loads — List all the loads on the
w| Print Shear Force Diagrams /| Print Bending Design Summary beams n table format Th|S WI” Slgnlflcantly
/] Print Moment Diagrams 7 Print Shear Design Summary increase the size of the report.

| Print Rebar Summary

| Print Design Forces Summary

Print Shear / Moment Diagrams - Print the
envelope shear / moment diagrams in pictures.

/| Print Deflection Summary

Beam Design Results Report can be prepared using this dialog. P ——
Select\Deselect . . .
Report will indude only the filtered beam axes in the Beam Design Table. Print Rebar and Axis Image — Prints

v x reinforcement design as shown in interactive
% L@ | Reinforcement Data interface. This will
significantly increase the size of the report.
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» Uncheck Print Beam Loads (so faster generation of report)

» Pick OK to generate the report.

Prota Scoftware Asia (21838)

Beam Reinforcement Design

Beam Reinforcement Design
Eurocode 2 (SG)

(EN 1992) Design of Concrete Structures (Singapore Annex)

Shear Diagram (Envelope )

Notation Definitions
foe Compressive (Cylinder) Strength of Concrete
fye Yield Strength of Longitudinal Reinforcement
Fymi Yield Strength of Transverse Reinforcement
E. Modulus of Elasticity of Reinforcement
bw Web Width
h Depth
d Effective Depth
Co-comprassion | Compression Reinforcement Clear Cover
Co-tengon Tension Reinforcement Clear Cover
. Compression Reinforcement Cover
Cension Tension Reinforcement Cover
Ag Gross Cross Section Area
Axis : A
Analysis Results

wl
7230 5758

GB1 G2
L=5.00 m) L=5.00 g
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> Exit & this report will automatically be saved & made available for compilation in Report Manager

» Click Detailed Report = uncheck all options for faster generation 2 OK

The report recreated has more detail containing clause by clause check, example below.

Rectangular Section Details ( Top Section )

Design Bending Moment

Depth

Maximum Allowable Depth tothe Neutral Axis
Equivalent Rectangular Compression Block Depth

Required Area of Tension Reinforcement
Minimum Area of Tension Reinforcement

Maximum Area of Tension Reinforcement

bw h Ag= beh |d Cocompression | € o tension Ccomprassion Ctansion

(mm) (mm) (m?) (mm) (mm) (mm) (mm) (mm)

250 500 0.1250 449 35 35 52 52
Bending Design ( Top Section )

Limiting Value of the Ratio of the Neutral Axis Depth to the Effective

Maximum Distance from Extreme Compression Fiber to Neutral Axis

Mzs = 61.5 kN.m ( Negative Moment ) — Tension steel will be
placed at the top of the section.

(x/d)m = (8-ki)/ ke = 0.5(Eurocode 2 (SG) 55.4)) —
fa=50.00 N/mm?

Xmx = (x/d)mad = 202 mm

amx = Axmx = 161 mm

a=d-V(d2-2Meq/ (nfabe) ) = 34 mm

a < amox — Tension-controlled section. Compression
reinforcement is not required.

As = Meg/ (fa(d-a/2)) = 327 mm2

Asmn = Max [0.26 fum/fy, 0.0013]bwd = 169 mm? (Eurocode 2

(SG) 9.1N)
Asror = 0.04 Ag = 5000 mm? ( Eurocode 2 (SG) 9.2.1.1(3))

ProtaStructure’
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» Double click on any of the beam axis in the list of beams in the Beam Design dialog.

The Interactive Beam Design allows you to examine individual beam design in more detail.

T - Reinforcement Data - Axis: A
Beams Rebars
[N, < Previous Span ) Copy Bars =™
g H I = E] « X
B Next Span [ Paste Bars =
Select Diagrams Detail Beam Design Not Scaled - 3 Summary Detailed oK Cancel
Bars Drawings  Parameters Span| 3500 ¢| [ rasteBarstoAl Report Report
Copy/Paste Reports Exit
Standard Pattern 2 s 2 3
t 3.00 i 3.00 y 3.00
1 v e < . B2 < . |ess A
327 102 327 342 150 342 1237 385 1235
Raniirec Ax(omz) G,“ 212 249 224 . 181 181 181 > 491 393 490
[ 250x500 ‘ ' 250x500 ' 250x600
' ' '
. 500 4500 , 500 4500 , S00 7686
; . t + . +
71 229 7 2071 1176 14 74
Extra As(mm2) 2 I ‘ 186 149 174 | I 40 5 4
As-min (Top) 3 169 169 169 169 169 165 203 207 203
As-min (Bot) 169 169 169 169 169 169 207 207 207
s-Bar-CL (Top) 4 <74> <74> <74> <74> <74> <64 > <64> <74> <128 >
s-Bar-CL (Bot) <74 > <74> <74 > <74 > <74 > <49 > < 49 > <74 > <49 >
Deflection Check 5 Ld=11.15 < 121.71 L/d =11.15 < 233.34 L/d = 1438 < 56.5
x-Sup. Links 1125 1125 1125 1125 1922 1922
Links ) 1H10-300 1H10-300 1H10-300 1H10-300 1H10-300 1H10-300 1H10-150 1H10-150 1H10-150
Top Bar 3U13 = ) 3H13 ) Q113 S
Support Top Bar 1 . 3H13 3H32 ]
< Support Top Bar 2 > 7
Bottom Bar 1 3H13 _ 3H13 = 3H13
Bottom Bar 2
Support Bottom Bar _1W13 _ 1H13 — 143
1H13
Web Bar
N 7

Reinforcement Data window shows the details of the beam design :

1. Required As is shown in blue as is based on design envelope of all load combination.

Extra As shows the additional or surplus area of steel based on selected steel.

As-min (Top & Bottom) is calculated minimum area of steel.

s-Bar-CL (Top)/(Bot) shows the spacing of the rebars at the outmost layer.

Deflection Check shows the actual vs allowable span/effective depth. The modification factor is

automatically applied.

x-Sup. Links shows the distance of the support region for links

7. Rebars designed are shown in the various rows including shear links, main bars & web/side bars.
These can be manually changed if desired.

uehwnn

o

Any figures in red indicate a failure to meet the design criteria and should be investigated.
» Click on the Beams tab at the top right corner.

This shows the summary of the beams parameters along this design axis including a 3D view.

T , Renforcement Data - Axis: A l - 0 X
Beams Rebars
@ T [(‘ v X
BeamDesign  SdeView DVew  OK  Cancel
Parameters
view Exit A
Axis: Storey: Part: Concrete: C30/37 - Fok = 30 - Fed = 20 (Njmm2) Beam Supports
Steel: Grade 500 (Type 2) -Fyk = 500 - Fyd = 434,78 (Njmm2) Beam Ae A I-End Axis 3 1
Enter Steel Bars Manualy (Do not design Clear Span 4500 mm 3-End Axis 2
bw 250 mm 1 - End Support 1C1
Sp Clear Spa bw
Axis Member = - Frll o n 500 mm 1-End Sup. Conditon Colum
&1 5000 50 20 500 delz -1 0 mm 3 -End Support 12
82 5000 4500 250 00 deiz -1 0 mm 3 - End Sup. Cond Column
a3 7888 7686 250 500 Concrete Cover (Top) 0 e 1 - End Upper Coks v
P @18 5000 %75 20 %00 Concrete Cover (Bot) 0 mm 3-End Upper Column Exist v
c G819 5000 4750 250 500
Edit Beam Secton
z rZd i
t- i
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» Go back to Rebars tab = Click on the Diagrams button to see the loading and design forces.

> Beam Design Diagram

Beam Axis
057116
1 1357
/| Display Detaied Values 78,62 *’f‘J‘ 7 _ gg%’ﬁé' 6738 708
/| Optimize Stations 'T/ =l :I',ﬁ: g i | A T
sgetorance: [ 20%]| Koz gour ] A Display Detailed 1 pal I A {

Disgram MJ/I/V Values e ILU/I/V W
a6 40
72.30 -61.68 abe B3 o

N viv2 v3 ame ID 84.27 84.39

T | M33 m22
v 82 33 |_ d D Distance :-‘ : 9 :

e 102G, |agrams 1044 0.5 08

& Deflections

a 6.76 6.776 -153.4 2.2
= 77.7 0.000 0.000 -101.7 5116.0
— = 77641

— q\“ - 52(Ma 0.000  0.000 eP8 ]\\N %M 434
Load Cases & Combinations M33 (kN.m) - - 1SN

h | (= T = R == T T
X 6 s eralX 27 -

Deflection Display Type:

o Q| L020S Cases &
bag Combinations

9.2326F-04

NQy 82 (m) ~ — —
., }‘»L‘FCRJ 01 -BA3TOEDT 0002

G40 61 62 85, 67, 89 T4 J4 J5 Jl. J4 53 58
Gy Frame ID 66 68 70 72 /4 76 78 60

GB1 GB2 GB3 GB18 GB19
G+Qly L=5.00 (m) L=5.00 (m) L=7.888 (m) L=5.00 (m) L=5.00 (m)

| Ea[x] . - Visualization >

‘Show Magnined Seismic Design Results Tools

R:;J E)x(t
Loads, Diagrams & Deflections
< Display Detailed Values:

e Checked: A tracing window will appear showing the exact values of the diagrams, e.g., shear &
moment, when the mouse cursor is placed at a particular location on the member.

« Optimize Stations:
e Unchecked: The diagrams are displayed using the default maximum number of stations.

e Checked: The number of stations will be reduced & optimized to maintain similar accuracy.

R

< Diagrams:
e L1/L2/L3: Checkto show slab loads decomposed & user-defined loads on beams.
e N = Axial force ; T = Torsion
e V2 =major shear ; M33 = major moment ; 62 = major deflection
e V3 =minor shear; M22 = minor moment ; §3 = minor deflection
« Deflection Display Types :
Deflections are calculated along the member span for each load case and combination. Deflections can

be displayed in three different ways:

e Absolute: The absolute rotation and deflection values display the deflected shape.

¢ Normalized: The absolute shape is normalized to the value calculated at the first point.

e Relative: The deflected shape is normalized to both start and endpoints. This is particularly
useful in determining the deflection relative to both ends in serviceability checks.

Visualization Tools & Report
< Horizontal Scale W 3> Increase or decrease horizontal Scale of diagrams.

< Default Display Scale E —> click to reset to the default scale.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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< Increase / decrease font size
«» Default Font Size Al -> Click to rest to default font size.

% Report ®' -> Generate a report in tabular format with/without diagrams.

» Exit the diagrams & Close the beam design dialog

The same beam diagrams can be assessed by :
> Select a beam on plan view =2 Right-click = Analysis Results Diagram
The same diagrams are used for columns & walls :

» Select a column or wall on plan view 2 Right-click = Analysis Results Diagram

g
> Alternatively, access the Interactive Column Design = pick ‘Diagrams’ =

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Slab Analysis & Design

For beam/slab models, slab reinforcement can be obtained by inserting slab strips in the X and Y
directions. This process uses the moment coefficient method of selected code. This is independent of

Page - 68

the general building analysis and can be carried out before or after the building analysis.

To use the moment coefficient method, it is essential to set all the Slab Types correctly per the provisions
of selected code. This can be done automatically in batch mode by right-clicking on the slab icon in the

structure tree and choosing Set Slab Types Automatically.

» From the Structure Tree, double click on storey St: 1 to return to the 1° Storey plan view.

» Right-click on Slab - Set Slab Types Automatically > Choose defaults options 2 OK

4 € Storeys
» © St: 0( +-0.00m)
4 © St:1(+3.00m, Sim:2,3)

» |' Columns

» [ ShearWalls

» (7 Beams

e ; B Slab Table
is” Ribbed Slabs =
& Slab Strips L. Slab Analysis and Design
X Braces k2= Slab DeflectionCrack Check
< Trusses
£t purlins == Slab Reverse Deflection Table
-~ Girts Set Slab Types Automatically

Ao namt . i

B, Messages

Unspecified Slabs:
GS3
GS10 (Edge Count> 4)

Spedified Slabs:
Gs4 (Type=7)
GS5 (Type=4)
GS6 (Type=7)
GS7 (Type=7)
GS8 (Type=4)
GS9 (Type=7)

Total Number of Slabs at the Storey=8 A
Count of total slab hole in storey=0

m} X

Slabs that do not have 4 edges is beyond the scope of the moment coefficient method. It will be
entirely up the user to set the appropriate slab type or use alternative finite element method to

analyse & design these slabs.

» Click OK to close the Messages dialog.

» Go to the Modelling tab & click on the Slab Strip

The Slab Strip Properties will be displayed:

e Slab Strip Type: Analytical Strip is used for design based on the Code Method. FE Strip is used for
innovation based on Finite Element Analysis results. Manual strip is used to manually input rebars

without any analysis & design.

e The correct “At Start” and “At End” boundary conditions must be
specified when drawing the strips. The three options are:

=+ Slab - The Strip starts or ends inside a slab. The bottom steel
for the slab in question is not designed, but the span of the slab
can be defined, and this value is used in determining the support

steel extension.

= Bob - The Strip starts or ends beyond an edge beam or wall.

The support steel at the edge is bent down into the beam/wall.

== Cantilever - The Strip starts or ends beyond a cantilever slab.

ProtaStructure® ProtaSteel

Skab Strip
General FE
X1 Dir: |2 X Y
Ne: | 1|8
Type: Analytical Strip | v
Boundry Conditions
g, | — | 9
AtStart: === |:'*I_
J (S| p—Y | ]
AtEnd: | == ——-| -.:'

ProtaDetails’
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» Set the Dir: to X Slab Strip .
> Set the No: to ‘1’ so that the strip label is X1 [ General [ E |

» Set Type to Analytical Strip ' - o @T '
» Set the At Start condition to Bob. _ No: | 1|3 _
» Setalso the At End condition to Bob.

Type: | Analytical Strip | v

Pick the slab strip’s start point outside the floor plan, as shown below.
—Boundry Conditions

» Hold down on the CTRL key and then click the end of the strip to the right e — [ [==

O

» Draw another similar slab strip X2 to obtain the design for the slabs between Axis B-C/1-2
» Draw similar slab strip X3 to obtain the design for the slabs between Axis B-C/3-4
» Draw slab strip X4 to obtain the design for the slabs between Axis C-D/1-4

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Now draw the vertical strips to design Y-direction rebar for the slabs. Skab Strip .

» Change the Dir to 'Y [ General
» Reset the No: to 1 again so that the strip label is Y1
» Keep Type as Analytical Strip No:

» Keep the At Start condition as Bob
Type: | Analytical Strip | v
» Also, keep the At End condition as Bob

Boundry Conditions
» Draw 4 nos. of the vertical strip through all of the slabs atstart: (2=

The final layout of strips & slab reinforcements should be as shown below. AtEnd: == T—

F
]

We can now re-check the strips as a batch and create a slab analysis & design report.

» Go to the Design tab - choose Slab Analysis and Design

E s Slab Analysis and Design m - 0 X
Design
v = ;
-, E,EE% = T? E [ Paste Bars E [ Mark All Siab Strips
Interactive Slab StripDesign ~ Settingsand  Filter  Copy Bars [, Paste Bars to Al Design @ Remove Print Marks
Design (Batch Mode) Parameters Report
Design Edit ~
Slab Strip Storey Type Analysis Results Source | Slabs U. Ratio Design Status ‘ Print Rebars
G52 (h=200 mm) - 16H10-300 + 19H10-250
X1 1 Span Strip - GS3 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250
GS1 (h=200 mm) 16H10-300 + 20H10-250 + 14H10-250
X2 1 Span Strip - GS4 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250 + 19H10-250
X3 1 Span Strip - GS5 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250 + 19H10-250
G56 (h=200 mm) 11H10-300 + 13H10-250
X4 1 Span Strip - GS7 (h=200 mm) 0.0 v z 16H10-300 + 19H10-250
G58 (h=200 mm) 16H10-300 + 19H10-250 + 19H10-250
G52 (h=200 mm) 16H10-300 + 19H10-250
Y1 1 Span Strip - G54 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250
GS6 (h=200 mm) 13H10-300 + 18H10-250 + 10H10-250
Y2 1 Span Strip - GS3 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250 + 19H10-250
Y3 1 Span Strip - GS7 (h=200 mm) 0.0 v Vv 16H10-300 + 19H10-250 + 19H10-250
GS51 (h=200 mm) o 14H10-300 + 14H10-250
¥4 1 Span Strip . GS5 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250
GS8 (h=200 mm) 16H10-300 + 19H10-250 + 19H10-250
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The slab analysis & design dialog will appear with a summary of pass / fail status, utilization ratio &
reinforcement. The functions at the top menu bar are :

% Interactive Design: Select a slab strip = Interactive Design will allow access to detail strip design

< Slab Strip Design (Batch Mode): Redesign or re-check the existing design of all strips at once

« Settings & Parameter: Opens up the slab design settings in the Settings Centre

< Filter: Allows filter by a storey, slab thickness, and design status

«» Copy Bars & Paste Bars: Allow copy & paste of bars of similar slabs marked with = symbol
« Design Report: Prints out the design report

> Click Design Report

The Slab Reinforcement Design report will be displayed. Options are available to configure and then
print it. Any failure in the design will be highlighted in the Notifications pane at the left.

slab Analysis and Design - 0O x
S .00% . X
Eﬂ |—\-) > FitPage Q [10.00 ¥ G Horizontal Ruler @ @ [ Tolmage -
= Bl 1y Fit Width @ zoomIn
P 0% e poges @ Zoamut 3 Vertical Ruler POF ToOffce [ Towed~
zoom Show Export
Notifications 2| I a2 s B B 1T B i e 10 Tl e T3t 0 6 1T 1181 118 4 12 "

Notifications  Headings

© Gs2:5upplied Reinforcement is Sufficent - Slab Analysis and Design
© Gs3:5upplied Reinforcement is Sufficient

- Notation Definitions

© cst:supplied Reinforcement is Sufficent - d lab's Efiective Depth
h lab Total Depth

© Gs4:5upplied Reinforcement is Sufficient . gmax ximum Load Combination

- L idth of the Siab Along the Stip Direction
© Gss:Suppied Reinforcement is Sufficient - M th o the Slab Pependicular 1o the S Direction
© Gsé:Suppied Reinforcement s Sufficent ; et f,"nf;c:“‘ C=M/(p12))
@ Gs7:Suppiied Reinforcement is Sufficient o As Area

© Gs8:5upplied Reinforcement is Sufficient -
- Slab Strip : X1 -- Storey : 1

© Gs2:Suppled Reinforcement is Sufficient

© Gs4:5upplied Reinforcement is Suffident = Materials : C30/37/Grade 500 (Type 2)
@ Gs6:Supplied Reinforcement is Sufficent = -
: dih qmax L, | Support] Span [ e Asleft | AsSpan | AsRight | | | soanpam | Right
@ Gs3:Supplied Reinforcement is Sufficient = sap | mm max L| ° C | Let | Requied | Requied | Requied o oy | “pongiy | Suppot
- Angle | Combination = M M Right | Provided | Provided Provided Straight Straight Straight
© G57:Suppied Reinforcement s Sufficient s C) | kNm) GNom) | GNm)| Nm) | Gomd) | () | (o) < < <
= G2
© GS1:Suppied Reinforcement is Sufficient - 5200|1287 | 500 | 00450 [000| 15 2%9 29 A9 | HIOB0 | oo | HIG2SO
N 0 136150\ 4| B1 |89 | @1 | e u9 B @ | MR Tm
@ G55:5upplied Reinforcement is Sufficient -
- G
© GSa:Suppied Reinforcement is Suffcient 2 %65200| 1287|5000 | 00450 [00340| 131 2%9 29 A9 | HIOB0 | oo | HIG2S0
0 [1386-150| 4| 31 | 99 | 15 | e u9 M ™) e ™
5200 1287|4331 | 001 |001| 115 | 249 29 A9 | HIOZO | oo | HIG20
0 |1356-150|4273| 80 | 61 | 08 e u9 34 ™) o ™)

Deflection Check

A0 1 e f60 1 150 180 gt
o
4

Slab Ud Udtssimem |5 Status v

Slab Analysis and Design | rage: [l 12 ‘ D NoErors @) NoWarmings () Messages: 16

> Review the report and then Exit
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Design Status

The design status can be displayed graphically in the plan or 3D window.

> Click on the 3D view to make it active

» Go to Review Tab - pick Design Status - OK

Analysis  Design  Drawings &Reports  BIM  Display

ews  Help
€ T, ey =
5 » = [H|H H s M 8
. ] 5 1 " U
v B i'?‘ : =1 Busst 1888/ o ] _ &
Fix the Purge  Refresh Connectivity Visual Design | Column Beam Sections Materials Beam Wal Slab Additional
xes Almost-Orthogonal Axes  Sections Information Interrogation | Status | sections Types Loads

Visual Interrogation

Storey: 1(30) X

Design Status

. Fail

D Warning

D Expired Analysis
B o«

D Not Designed
. Do not design
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Quantity Extraction Tables

The concrete and Formwork quantity reports can be produced.

» Go to the Drawings & Reports tab = Pick Quantity Extraction Tables
» Choose Concrete Quantity Extractions Table = click Calculate

As shown below, this produces a concrete quantity report with member type and storey breakdown.

» Click Report to produce a detailed report

Project Preferences

The Project Preferences dialog allows you to enter the details of the project model.

» Go to Building Setout tab = Click on Settings Centre = Project Preferences = Header

Options

Licence: Prota Asia (21838)
» ° ProtaStructure Environment

Consultant
» ° ProtaDetails Environment

Calculated by:
— Controlled by:
4= Pll'oject Preferences Drawn by:
| Title Presented by:
Statistics Project
Notes Client Mame:
=0 Unit and Format Project Tite:
b Et: Label Project No:
|2) Codes Project Date:
3H Lateral Loading Project Address:
[] Lateral Drift & Bracing Revision No: 1

Title - Enter the Consultant and Project details to be displayed in the header of all the reports.

Statistics - Show graphical chart of essential model information such as the total number of members,
member types, grids & storeys. In addition, it shows the number and types of foundation, beam &
column end releases. A text file can be created.

Notes - Enter additional information on this model, such as revision changes, etc.

» Key in the various information in the Title tab as desired

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’

Quantity Extraction Tables X |
Quantity Tables
Tables
. T Storey Beam Column Slab Rib Slab Blocks Foundations
| Concrete Quantity Extractions Table; Foundation 0.00 5.71 0.00 0.00 0.00 0.00
Formwork Quantity Table 1 10.76 15.56 32.69 0.00 0.00 0.00
w
2 10.76 15.56 32.69 0.00 0.00 0.00
3 10.76 15.56 32.69 0.00 0.00 0.00
4 10.76 15.56 37.20 0.00 0.00 0.00
(1 Total 43,03 67.96 135.27 0,00 0.00 0.00
Calculate
Help F1
Total Concrete: 246.25 m3 J X
Report Close
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Report Manager

The Report Manager is the central report manager where all analysis and design reports can be accessed
and managed.

(=
» Go to the Drawings & Reports tab = choose Report Manager =
= Report Manager (Ed ] x
Current Set: =t . Add All Availabl = [m]£=
et =E ™ New & alsne x + Expand Al ‘!] Load Logo
- = ?
Default v [ Add Al “ PROTA
View ™ pelete | New Report - Collapse Al | Use QR X Clear Logo
. [> Remove Al From File Code
Report Sets Reports Header Settings
== 4 Model Information
Default | == 1T 1 x 2 Notifications QLD & »
Pre-analysis Checks Quick_Start_Guide_Complete-...
Beam Loads Beam Loads Quick_Start_Guide_Complete-... || 4 Post-analysis Checks
) _ Warning: Dir 4... Effective Mass Ratio is less than
Slab Additional Dead Loads Quick_Start_Guide_Complete-... 0 90%. Number of effective modes should be increased
d ly: t be ted.
Beam Wall Loads Quidk_Start_Guide_Complete-... BNE ANSYSS Must be repes
Analysis Model Echo Report e e— o (B2) Irregularity Check is not performed. !
@ Overturning Check: Dir 1... Mp1 /Mal = 61850.3 /
Storey Displacements } Column/Wall Design Reports 751.2 = 82.3408 = 2.0 OK

Axial Load Comparison Report

Report Sets

0 Overturning Check: Dir 2.... Mp2 /Ma2 = 61055.5/
AO7 S = R7 51 >70 NK

-

feampesionRepers  Reports Repository

Slab Design Reports

-

Notifications

Beam Quantity Report Foundation Design Reports

-

-

Quantity Take-off Reports

-

Building Assessment Reports

-

Other Structure Components

Reports Ready: 11/50

e Report Sets (left): This shows the constituent reports, which will be complied & combined into a
single final report.

e Reports Repository (middle): All the individual reports generated and available to be included as a
Report Set.

¢ Notifications (right): Important notes and warnings from the model’s analysis are shown for easy
reference.

You can expand or collapse the main folder by clicking on topic icons. To create a combined report:

| New
> Select New *~ ' inthe Report Sets tab and give the new report set a name.

» Select Add All Available Ce. reports in the Reports window to include only available and generated
reports in the report repository.

Alternatively, click and drag a report from the Reports Repository into the report Sets pane.

» Choose to insert Table of Contents =
tab.

and Summary Report i= using icons below the report Sets

» Select View & to generate and view the report set.

Other useful functions include loading of company logo : Load Logo !, inserting QR Code o & inserting

external .doc or .rtf files : New Report from File LE}

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Steel Model

Page - 75

We will now start a new steel model. This section will cover steel members, trusses modelling, analysis
& design. The below is the screenshot of the completed model, which can also be found in the default

Project Data folder.

» Click New Project " and type the project name as shown using the *_’ character for spaces.

New Project

Project Code: |Quick_Start_Steel

(Available Characters: A-Z, a-z, 0-9, _

Templates

Search....

Ireland (Eurocode)
Malaysia (B58110)
Malaysia (EC2, EC8-DCH)
Malaysia (EC2, EC8-DCL)
Malaysia (EC2, EC8-DCM)
Malaysia (Eurocode)
Philippines (ACI318, NSCP2015)
Poland (Eurocode)
Singapore (CP65)
{Singapore (Eurocode)
Thailand (ACI318, IBC)
Turkey (TS500, TBEC2018)
Turkey (TS500, TEC2007)
UK (BS8110)
UK (Eurocode)

@ Templates:

Projects
D:\chunfei\Documents\ProtaData2020\ x
(2 v x
Help OK Cancel

» Select Singapore (Eurocode) template and then OK

)
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Axis Creating & Storey Insertion

» Go to Modelling tab =2 Pick Orthogonal Axis Generator in the Modelling tab.

» Pick the intersection of the primary grid near the origin (5000,5000 coordinate).

» In Orthogonal Axis Generator, change Dir-2 Axis Spacing to 5000*2 & click OK.

Orthogonal Axis Generator

GridInsertion
Reference Point - x: 5000 mm -y 5000 mm
Insertion Angle: 0.0°
Dir-1 Axes
Axis Label: |A Step: 1 .
Axis Spacing(s): | 5000%3
Axis Extension Length: 2000 mm
Dir-2 Axes
Axis Label: |1 Step: 1 0
Axis Spading(s): | 5000%2|

Axis Extension Length: 2000 mm

Axis Spacings. You can delimit values with comma character if unequal spadings used. | A
Repeating spacings may be entered using '* as multiplier, provided that spacing to be
written before number of spans. (Ex: 5000, 2000*3,4000)

(2) v X .

Help F1 OK Cancel ﬁ
X

» Right-click on Storeys in the Structure Tree and pick Add new Storey.

4 H structure
b :T_T Axis
4= Views
Te | Storey: 1 (Plan)
= Reports
Detail Previews
Jf€
b © St0(+d E(‘ Select Storey

4 0 St1(+3|E" Insert Storey

) Columes B€ Generate Storey

- [ Ry

Page - 76

Input Storey No.: = 2 = OK. Leave Add Intermediate Story and Generate Members from Selected

Storey unchecked.

Add Storey

Storey No.: 2 Inserted Storey Height: 3000 mm
Add Intermediate Storey

Generate Members from Selected Storey

A storey number greater than the top storey will add storeys above.

Entering the number of an existing storey will insert a storey by shifting the selected one.
When the 'Add Intermediate Storey' is checked, then the selected storey height will be
sub-divided in two storeys.

[2) v X

Help F1 OK Cancel

When prompted to confirm =2 Pick Yes = The plan view will now change focus to Storey 2

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Materials & Load Case / Combination Generator

» Go to Analysis tab = Building Analysis - Pre-Analysis tab.

> Pick Edit Materials = Change the steel grade of all members to S355 (as shown below)

“o Material

Default Materials
Foundation Floor

Concrete Columns

Concrete Walls

8

Longitudinal Web Bar
Harizontal Web Bar

Conarete Beams C30/37
Slabs C30/37
Rib C30/37
Links

Steel Columns 5355
Steel Beams 5355
Truss Members 5355
Purlin Members 5355
Girt Members 5355
Brace Members 5355

Storey Having x
Nifferent Materi

Grade 500 (Type 2)
Grade 500 (Tvpe 2)

X

Rebar Diameters

Rebar Diameters

Grade 500 (Type 2)

Rebar Diameters

Grade 500 {Type 2)

Rebar Diameters Shear Modulus

Grade 500 (Tvpe 2)

. Poisson's Rato
Rebar Diameters

Grade 500 (Type 2)
Grade 500 {Type 2)

Thermal Expansion Coeff
Rebar Diameters »
Unit Weight

Rebar Diameters Design Parameters

Grade 500 {Type 2)

Rebar Diameters Minimum Yield Strength

oK

Tensie Strength
Bearing Strength
Material Coeff

Standard (Norm)

¥ cancel

|¢ Apply to all members of this matenial dass in this storey! |

79434.0 Njmm2

: 0.30
: 0.00001200 (1/°C)
: 78.500 kNjm3

: 355.00 Njmm2
510,00 Njmm2

1 415.00 Njmm2

T EN 100252

v

Page - 77
Steel
Steel
e = General
= Material Name 55
Material Color : WO, 192,192
Hechanical Properties
Maduius of Elasticity 1 206182.0 Njmm2

oK

The global materials grade of the truss, purlins, girts & brace members are shown & can be changed.

K cancel

Individual member material can also be changed in their respective Section Manager dialog by selecting
the member = Right-click = Edit Section / Material.

We will now auto-generate the load cases and combination (required to add roof purlins loads).

» Pick Loading Cases and Combinations to access the Load Combination Editor.

Load Combination Editor
P-Delta Analysis

Apply P-Delta Analysis

Approximate slenderness checks using moment magnification

No | Combination LL Red
1 6+Q o

2 G+Qp1

3 G+Qp2

4 GHQ+HNx
5 G+Hx+Q
6 G+Q-x
7 GNx+Q
8 G+Q+\y
9 GHNy+Q
10 G+HQ-Ny
11 GNy+Q

R/C | Steel

v

VoM

JRAK KRR AR K
JMRIRR RIRK KR RTR
JRIRR KRR R R K

Loading

Generator Load Cases

Add Delete

method will not be applied when P-Delta analysis is performed.

Totals

1.35
135
135
1.35
1.35
135
135
135
1.35
135
135

Number of Vertical Load Cases = 4
Number of Lateral Load Cases = 4
Number of Thermal Loading Cases = 0
Number of Stage Construction Load = 0

Q Qpl Qp2 NGx NQx

1.50 0 0 0 0

0 1.50 0 0 0

0 0 1.50 0 0

1.50 0 0 135 150

1.05 0 0 135 1.05

1.50 0 0 1.35 1.50

105 0 0 L35 L05

1.50 0 0 0 0

1.05 0 0 0 0

1.50 0 0 0 0

105 0 0 0 0

NGy

oo o o oo

1.35
1.35
-1.35
-1.35

Help F1

v
oK

NQy

o o0 o0 oo o

1.50
1.05
-1.50
-1.05

X

Cancel

» Pick Loading Generator to access the Automatic Loading Editor.

ProtaStructure’

ProtaSteel’
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» In the Automatic Loading Editor, pick the options as shown below =2 click OK.

Automatic Loading Editor
I v Create Different Combinations for Steel Member Deswgn] V.Load Case = 5
Use Cracked Sections in All Vertical Load Combinations As Well H.Load Case = 4
Vertical Load Combinations Horizontal Load Comblnanc—ml Horizontal Load Combinations I

| Define Dead Load Case (G)

| Define Live Load Case (Q)

v/ Define Pattern Loads Automatically | Apply 30% of Other Directic

vi=_=_.. S Add Vertical Seismic Case
v

Direction Dependent Pattern Loading

Snow Load  wO: 0.5

/| Define Combinations for Roof Live Load (Qr):

Define Combinations for Snow Load (5):

Define Combinations for Rain Load (R):

» Load cases & combinations will be generated. Pick OK & Close the building analysis menu.

Steel Columns Creation

» Click on Steel Column [” in the Modelling tab.

coumn ) > In Column Properties, change Len (Storey) to 2
Gen e0
: This means the column will span 2 storeys with effective length of
L‘Te“[s‘o v)‘m “2 2 storey height. Thus, we do not need to model any column in
: STO1.
b1:
T bz[ 2w » Change the Angle of rotation to 90 degrees.
B e omm This will rotate the steel section 90 degrees on plan view.
Pt ez 0mm
—— » Pick Section Manager icon I
got:| A || 3 This will launch the Section Manager dialog which allows us to pick
Bot Insertion Point: |

a section profile.

_Ang\e: 90.0 ®
I Dm— ﬂ Column End Condition: Columns ends are fixed by default. You can

apply hinges to top and/or bottom by clicking successively on this icon.

> + Update X Close
Column Steel (UC 300x200x93)
batobase | pragct > In Section Manager dialog, pick Singapore.
H B1 M . . ) .
- e This will access to Singapore Steel Profiles
SINGAPORE » 125 25 26 29 30 .
175 44 44 52 59 (Contmental)
[0 67 e .
T R » Pick UB 250x250x67 > Select.
69 . .
w8 m & 7 » Pick OK to close the dialog.

87 106 125 130 147

» Enter eight nos of columns along Axis 1/A-D & 3/A-D

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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v Storey: 2(3D) X

w

Bot: A

Bot Insertion Point: |

Angle: 90.0°

Dir: | 12| 1 2

[

@
/

«” Update K Close

pr— 1] 2
° " " ® C
|
‘ (=)
‘
|
3 " " O}
|
| —
+ | \ &/
|
0 - o s \ \
| \ =
| | \‘», o) g
| | \ - \
| | A
e B = wil=a \
= == :
J\‘ N\~
» Right-click on Views in the Structure Tree and pick 3D Physical Model.
4 H structure
b I Axis
(e | Storey: 1 (Pla Te| Plan
= Reports T/ 3D Physical Model
Detail Previews
i Analytical Model
4 §€ Storeys %‘ y
This command will create a separate window showing the 3D view.
» Go to Views tab — Tile Vertical
This command will arrange the 3D view and plan view in 2 windows.
» Click on the Plan view to make it active (the active view title & border will be darker)
» Double-click on Storey 1 in the Structure Tree to switch focus to Storey 1
17\‘ i \ 3 //
N o 1’ “ 4
\ A -
‘ v 2
Column x i ) -2 &
m G o =%
Gen rof 3 & > a
e L2 | P :
Label: 8[43 ‘ £ & @,
| ol P ¢
p ¢
I bi: ‘ ~ P . > 0
T bz: 248 ‘ o o
i ‘ >/ B . / ) 7/
{ed el: 0 mm E . ‘ ‘ c ‘ $ >
- a2 0mm ‘ Nt '{" £ < n
Top: ‘ > $ / & ";i'\
‘ o /
|
\
\
|
\
\

» Click on the Steel Column icon I

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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» Change Len (Storey) to 1 in Column Properties
This property means that the column will only span a single storey.

The columns with “Len = 2” are grey in STO1 because they were inserted in ST02.

Ensure the angle of rotation is 90 degrees.

Pick Section Manager icon I

Ensure that the same UB 250x250x67 is selected.

YV V V V

Insert three nos. of the column along GL2/B to D.

Check the 3D view to ensure the columns were properly.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Steel Beams Creation

> Click on the 3D view to make it active (the active view title & border will be darker)

» Double-click on Storey 1 in the Structure Tree to switch focus to Storey 1.

Notice the grids will move to storey 1. This operation ensures beams to be created in St: 1 in the 3D
view.

» Click on Frame icon #

> Then select Steel Beam ¥ “*"

» Click on Section Manager L inBeam Properties

Beam Steel (UB 250x250x67)

» In Section Manager dialog, pick Singapore flag.

Database rojec _ . . . .
- — m This will access to Singapore Steel Profiles
H B1 M .
— --- 26 29 30 (COﬂUnental)
S cparore | v
175 44 4 52 59 .
e > Pick UB 250x125x25 > Select.
DS“ N0 | 150 2: 27w > Pick OK to close the dialog.
. ‘ 200 48 56 57 65 77
End Releases
N V2 V3 T M2 M3
I Al »
. . . ry
» End Releases: Click successively to hinge both ends of the beam 1 o

» Click on the 3D view to make it active > Double-click on St: 1 to make it the active storey.

» Inthe 3D view, create seven nos. of beams in the region bounded by GL B, D,2 & 3 (as shown below)

&3
' S

k
‘E
‘5
\

\
o

=
B S

»)
»

110 e 22

» Go to the plan view of STO1 2 Create four nos. of UB 200x150x30 secondary beams in the region
bounded by GL B, D,2 & 3 (as shown below)

» Ensure both ends of the beams are hinged End Releases: | =4

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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P
¢
§
3
g
=}

“ﬁ
. G i
S

\

Use smart points
0.67 to create these beams|,

@0.33&

o

1,18 a0sas ‘ 1. mzses
¥ 7
£ i
¥

\

\

18
W

Use smart points to create secondary beam. With beam properties out, place the mouse cursor at the edge
of the primary beam (not centre) & the smart points will appear at 0.25L, 0.33L, 0.5L & 0.75L.

9
o

Use Beams Sections W in the Review tab to show beams of different sizes by colour. Assign colours to
members in Section Manager dialog > Material Colour

Steel Truss Creation

We will now insert roof trusses. Trusses are best inserted using the 3D view.

» Go to the 3D view = Double-click on St: 2 in Structure Tree to make it active & grids are at St: 2

» Click on the Truss icon r’-'&

ProtaSteel’

ProtaStructure’

»  Pick grid intersections A/1 to define the start of

the truss.

A dynamic rubber band will appear with the
default truss type if no truss is defined before.

» Pick grid intersections A/3 to define the end of

the truss.

After you pick the second point, the truss
generator dialog will appear.

ProtaDetails’

ProtaBIM’
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- uss Generator gaad = b
General Spices Members
N s 3 B e
+ 2 - - 1 3
Import  User Defined Load From Wrre Frame Shrinked Reset oK Cancel
From DXF Truss Library View
Truss Types Patterns Label: |8
‘. Geometry A
AN NN NN N NN NS @ | oo
""" Divide Cross Diagonal Fra
Invert Truss
Enliieal s Rught Vertal Offset w 0mm
Left Cantiever Length oL 0mm
AN 5522 e =
Mode! Joints as Fixed
i | Apex
Apex Height HA 1500 mm)
Place Apex Symmetrically v
Heels
Enter Left Heel Angle By A
Left Heel Heght "
Enter Right Heel Angle By
Right Heel Height .3 00 mmi

» In Geometry, pick Duo-Pitched truss = Change Truss Support Placement to Top chord.

» Change Apex height to 1500 mm, Left & Right Heel height to 800 mm.

» Click on the Members tab

a2 T Truss Generator
General Splices Members
A e
F "\. x @ L '? V x
Reset Delete  Wire Frame Shrinked Reset oK Cancel
Members View
View

4 Top Chord %}’;’,";"ﬂ [ Top Center Fixed (1) Fixed (3)
12 /3% Top Center D D
13 RHS 150:75%3 Top Center O O

4 Bottom Chord Bottom Center Firced (I) Fixed (1)
14 HH UX /9K, Bottom Center |:| |:|

4 Diagonals Middle Center Fixced (1) Fixed (7)
1 SHS 75%75%3 Middle Center O O
3 SHS 75x75x3 Middle Center O O
5 SHS 75x75%3 Middle Center O O
7 SHS 75x75x3 Middle Center O O
9 SHS 75x75%3 Middle Center O O
11 SHS 75x75x3 Middle Center O O

4 Verticals Middle Center Fixed (I} Fixed (3}
2 SHS 75x75x3 Middle Center O O
4 SHS 75%75%3 Middle Center (] (]
6 SHS 75x75x3 Middle Center O O
3 SHS 75%75%3 Middle Center (] (]
10 SHS 75x75x3 Middle Center O O

» Change the truss member sections to the following by click on the section name:

e Top & bottom chord = RHS 150x75x3 (Singapore)
e Diagonals & Verticals = SHS 75x75x3 (Singapore)

» Click OK to exit the Truss Generator dialog.

The truss will be inserted. The truss insertion will automatically switch into copy mode & you can pick

the next point of insertion.

ProtaStructure’

ProtaSteel’
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Purlins Creation

We will now insert purlins on the roof trusses. Purlins are best inserted using the 3D view.
>

>

automatically

found)

Click on Purlin toolbar button sk

On Purlin Dialog, you can specify the following:

e Profile / Section of the for the Purlin.

Page - 84

» Insert 3 nos. of similar trusses by clicking grid

intersection B/1, C/1 & D/1

»  Press ESC or Right-Click to end the copy
operation.

To enter copy mode manually, select the truss 2>
Right-click = Pick Copy

» Select the basepoint @ intersection of A/1
» Insert 3 nos. of similar trusses by clicking grid

intersection B/1, C/1 & D/1

Select the first truss @ GL A = Select the last truss @ GL D (Intermediate trusses will be

e Section Alignment: On the Section / Under the Section / Centre.

e Generation Method: By Truss Joints / By Spacing.

e There are many other options. Refer to the diagrams as a guide.

e The 3D diagram on the right can be rotated (right-click & drag) & zoom in/out (mouse wheel)

EE Purlin
Label:

General

=]

Sag Rods

Load Display Mode

Local Axes

v | Section Properties
Profile

Section Alignment On The Top Chord
Section Alignment On The Bottom Chord

Generation Options
Placement
Generation Method

Delete First Member
Delete Last Member
Left Cantilever Length
Right Cantilever Length

Con Bobhusan Cantinuaus Dudline l

Ho

o IEH

A
On The Section
On The Section

Top Chord
By Truss Joints
Default

¥ oK K cancel
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» Choose section UPN100 (under Steel = European sections = UPN)

Purlin Steel (PFC 100x50)

Database | Project

H

80
© i
120

» In the Sag Rods dialog = Insertion Method = Choose None to remove all sag rods (for simplicity)
LL purlin

Label: 2p1 [PrC 1[5~ | 530 Rods

Insertion Method
General
Geometry
Sag Rods

» Pick OK to exit the purlins dialog.

We will insert the roof loading using the more specific Cladding function.

Creating Cladding & Loads
» Go to Modelling tab = Pick Cladding < 2 Select any purlin.

The Cladding dialog will appear to insert roof loads on the purlins.

In the Geometry dialog, the cladding geometry can be adjusted by selecting the point and changing
the values in the vertical and horizontal direction.

e Point Horizontal Dir  Vertical Dir - N
Label: x1)8 Group 1-P1 0mm omm
Group 1-P2 omm omm
General ® |Group 1-P3 0mm omm >
Group 1-P4 0mm 0mm 4
Geometry Group 2 -P1 omm amm b
Group 2-P2 0mm 0mm q
Group 2-P3 0 mm 0mm
Group 2 -P4 0mm

v |Group3-P1 0mm

Group 3-P2 omm

P1

Group 3 -P3 0mm
Group 3 -P4 0 mm Omm| .

Load Display Mode

None
Selected

® al

Local Axes !
| Display

v K ¥ cCancel

» Click OK to exit the cladding dialog > The cladding will be rendered on top of the purlins.

» Go to the Structure Tree > Cladding > Select the cladding label

-

4 7™ Claddings yii- Edit Loads

> Right-click > Pick Edit Loads . 1

The load editor dialog will appear, which allows you to insert area load on the cladding.
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{
:
EIAN
¥ X

Select Members by picking or drawing a window for Load Assignment

1
o]

| J

=)
*. .

= | BV s S Bt G R

GE:mm , Ani: kN-m , Disp: m

At the top, pick Full Uniform Area Load

Pick G Load Case in the left pane.

In Load Properties, ensure Load Direction = Gravity & Magnitude = 0.5 kN/m?
Click & drag window over the entire roof cladding to apply all panels.

Pick Q Load Case (Roof Live) in the left pane & Full Uniform Area Load

In Load Properties, ensure Load Direction = Gravity & Magnitude = 0.7 kN/m?
Click & drag window over the entire roof cladding to apply all panels.

Click OK to save & exit the load dialog.

=

You can switch off the cladding Layer a by going to the Display tab > Layers.

V VYV V V V V V V V

This operation will make the view less cluttered & make the selection of other members easier.

Braces Creation
We will now insert some bracings between steel columns.
> Click on the Brace toolbar icon X

» Pick two adjacent columns at A/1 & B/1 = Brace Dialog will appear.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"



S PRoTA

Page - 87
Brace

Brace Group Count Label: 2|8 Reset View
St - Section and Type 3 —
1 2
Align to Shorter Member Frofle L ﬂﬂ

Brace Type X Brace

Out of Plane Alignment Center F

Out Of Plane Offset 0mm F 1 _|

In Plane Alignment Original

Divide v

Model joints as fixed

Properties of Frame 1 (F1)

1End x-Offset 0mm

1End y-Offset 0mm

. | JEnd x-Offset omm
i | JEnd y-Offset omm

Frame Rotation -80.0 ®

Properties of Frame 2 (F2)

1End x-Offset 0mm

1End y-Offset 0mm

JEnd x-Offset 0 mm

JEnd y-Offset 0 mm ;

Frame Rotation -90.0® F1-J ,

F2
X
v oK X cancel

» In the Brace dialog, you can specify the following:

Y V

Profile / Section of the for the braces
Brace Type (Diagonal, X Brace, Y Brace or K Brace)
Alignment & Top/Bot Offsets
Apply to analysis: offsets will affect the analytical model.
Accept all defaults & click OK.

Insert the same bracing between columns A/3 & B/3

» Check the braces are correctly inserted, as shown below

(y)
)

» Insert new brace between columns C/3 & D/3

ProtaStructure’
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Brace

Brace Group Count Label: 3|8 Reset View

Count 1 <>
Section and Type

1 3

Align to Shorter Membe: Profile L80X8

N to Shorter Member
= Brace Type <]

Out of Plane Alignment Center F
Out Of Plane Offset 0mm
In Plane Alignment Original

Invert
Model joints as fixed
Properties of Frame 1 (F1)

1End x-Offset 0mm
1End y-Offset 0mm
. | JEnd x-Offset 0 mm
JEnd y-Offset F1 .
Frame Rotation -90.0 °

x
v o |[X concl
» Change Brace Type to Diagonal
» Input J End y-Offset = 3000 mm (rest remains 0 mm)
» Click OK = Diagonal Brace will be inserted.
» Insert another new diagonal brace between the same columns C/3 & D/3.
Brace
Brace Group Count Label: 4|8 Reset View
ount 1 - <4 —
ign to Shorter Member Brace Type Diagonal <
Out of Plane Alignment Center
Out Of Plane Offset 0mm
i::’:tne Alignment Orl
Model joints as fixed
Properties of Frame 1 (F1)
1 End x-Offset 0 mm
==
t | JEnd y-Offset omm F1 =~
Frame Rotation -80.0°
F1-J L: :
X
v oK X cancel
» Ensure Brace Type = Diagonal
» Tick Invert =2 this will invert the diagonal.
» The input | End y-Offset = 3000 mm (rest remains O mm).
» Click OK =2 A new diagonal brace will be inserted.
» Check the braces are correctly created in the 3D view as below.
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Horizontal braces can also be inserted between beams. Create three horizontal braces connecting the

beams in STO1, as shown below.

—— T, S
—Tt LNl .
= AVFA B =

2 "

Model 3 horizontal
i braces

Pick 2 adjacent beams.

In the Brace dialog, pick Brace Type =
Diagonal

Tick / Untick Invert as required by verifying
the right-side brace diagram.

Ensure all | & J End Offsets = 0
Click OK

Check the brace is correctly created as
shown in the left figure.

Repeat the same steps to create total of 3
horizontal braces as shown in the figure.
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Girts Creation

We will now insert some girts between steel columns.

»  Click on Girt toolbar button n

»  Select the first column at grid A/3 =2 Select the last column at grid D/3.
Intermediate columns will be automatically found.

» In the Geometry dialog, you can specify the following:

e  Profile / Section of the Girt
e  Section Alignment: Under The Section / On The Section
e  Spacing, Delete Bottom / Top Member, Left / Right Cantilever, Offsets

~ Girt o IEH
Label: 2G2 { | Section Properties
Profle UPN100
General Section Alignment On The Section

Generation Options E’

Geometry Fill From Top

Sag Rods Spacing s 1000.m 4
Delete Bottom Member
Delete Top Member %
Left Cantilever Length Le 0Omm
Right Cantilever Length Re omm
Gap Between Continuous Purlins d 0mm
Offsets

Load Display Mode

Perpendicular Offset Vo 0mm

T Momb e OEEant Aa P

Local Axes

v oK X cancel

The insertion of the girts depends on the sequence of clicking the members as this will determine the
correct Section Alignment. For example, if you click the column at A/1 followed by the column at D/1,
the girts will be placed at the right-hand side of the column i.e., at the internal part of you structure
when Section Alignment = On the Section. Therefore, you will have to change Section Alignment = Under
the Section if you would like to have the girts modelled at the external part of the structure. Likewise, if
you click the column at D/1 followed by the column at A/1, the girts will be placed at the left-hand side
of the column i.e., at the external part of you structure when Section Alignment = On the Section.

Inserting the girts b clicking on the members at any sequence are both correct so long as you define the
section alignment correctly to ensure that the girts are modelled correctly.

»  Ensure Profile is UPN100 (under Steel = European sections = UPN)

»  Ensure Section Alignment is On The Section.

» Tick “Delete Bottom Member” so that bottommost Girt is removed.

In the Sag Rods dialog, you can specify the configuration of the sag rods. For simplicity, we will not
insert the sag rods for this model, as there are minor elements.
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» Inthe Sag Rods dialog = Insertion Method = Choose None to remove all sag rods

 Girt
H -
Labe 2G2(8 Sag Rods
Insertion Method None | v
General
Geometry
Sag Rods

> Click OK, and the girts will be inserted.
» Insert similar girts between columns A/1 & D/1 but Section Alignment = Under the Section.

>  Check the girts are inserted correctly at both sides of the building, as shown below.

A)

/), /"’ ]

\/
N

X\

Loads can be applied to girds similar to Purlin by creating a cladding first. For simplicity, we skip this.

Column Splice Creation

Press ESC to deselect all members.

Select the corner column at GL D/3

Right-click = Define Splice

Pick Add New Splice in Splice Location Definitions
In Member Splice Definition choose :

Member Spice Definitions 1]
Ref, Storey No:

e 1 v
e: 800
Splice Width:] | 500

YV V V V V

e Reference Strorey =1
e Splice Distance (from floor level) = 800 mm
o || cancel e Splice width =500 mm

ll » Click OK

The splice will be created & listed in Splice Location
Definitions.

storey level.

rd Edit Selected Splice

x Delete Selected Splice

» Close Splice dialog
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Building Analysis
» Go to the Analysis tab = Pick Building Analysis
> In Batch Design Options, choose not the design any members = click Building Analysis
Once analysis is completed, the Analytical Model view will open automatically.
» Review the results in the Analytical Model view to your satisfaction as outlined in previous section.

For example, check if the roof cladding loads have been correctly considered by switching on the Frame
Loads & Frame Load Labels.

Steel Design
Steel member design commands can be accessed via the Design tab.
Building Setout Modeling Loading Review Analysis Design Drawings &Reports BIM Display Views Help

=8 T 0 w i = T < gp % s&<=[I I Xoda

Design Columns ~ Storey Prestressed RibBeams Foundation Slab Analysis Ribbed Slab  Pad Footings Pile Caps Column Beams Slabs Ribbed Columns Frames Eraces Purins Girts  Trusses

Al Beams Beams Beams and Design Analysis Punching Check Slabs
Design Reinforced Conarete Deflection/Crack Chedk Steel

» Go to Design tab = Design All =2 Pick Steel Member Design Check = OK.

+» This will check all the adequacy of assigned all steel members in one go.

¢ The program does not automatically select the smallest section size.

«» If the model is large, it is recommended to perform design check by member types separately.
+» To access a summary of member design check, select the steel member icons in the steel group.

+» To design only a single member, select it = Right-click > Steel Member Design

»  Pick steel Column Design T to access the design summary of all steel columns.

Steel Column Design
I ; ;I:]’: ‘i’ f [3f Mark all for print IEI1 IEI" X
Check Check  Filter 3 @ Remove all print marks Design  Detailed Close
Selected All R Report Report
0
Member Label Storey Print | Section Material Section Class Slenderness Ratio (kL/fr) Utilization Ratio Design Status Governing Check
2C1 2 W UB 250x250x67 5355 Class1 95 < 200 0.05 < 1.00 Pass v (Combined)
202 2 v UB 250x250x67 5355 Class1 95 < 200 0.15 < 1.00 Pass v (Combined)
203 2 d UB 250x250x67 §355 Class1 95 < 200 0.15 < 1.00 Pass (Combined)
204 2 W UB 250x250x67 5355 Class1 95 < 200 0.05 < 1.00 Pass (Combined)
205 2 v UB 250x250%67 5355 Class1 95 <200 0.05 < 1.00 Pass + (Combined)
206 2 o UB 250x250x67 5355 Class1 95 < 200 0.14 < 1.00 Pass (Combined)
207 2 W UB 250x250x67 5355 Class1 95 < 200 0.13 < 1.00 Pass (Combined)
08 2 W UB 250x250x67 5355 Class1 95 < 200 0.05 < 1.00 Pass / (Combined)
ics 1 ' UB 250x250x67 5355 Class1 48 < 200 0.01 < 1.00 Pass (Combined)
1C9 1 |  UB250x250x67 | S355 Class1 48 < 200 0.03 < 1.00 Pass v (Combined)
1c10 1 o UB 250x250x67 5355 Class1 48 < 200 0.03 < 1.00 Pass (Combined)

Total number of members: 11

» Double-click on any column to review the detailed design checks.
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v
x
v

Check
Design

58
Change
Section

Design
Report

| Design Summary

—
I Parame(ersl

II"“
h

Stations

e
A

Show Design  Show Diagrams Detailed

Iy

OK

Report

[ N ]
Local 2
L s ]
Local 3

Section UB 250x250x67
Section Width 245 mm
Section Height 248 mm
Flange Thickness 13 mm
Web Thickness 8 mm
Section Area 0.0085m2
Shear Area 3 0.0065 m2
Shear Area 2 0.0020 m2
Torsional Constant 4.670E-07 m4
Moment of Inertia 33 9.931E-05m4
Moment of Inertia 22 3.348E-05m4
Radius of Gyration 33 108 mm
Radius of Gyration 22 63mm
Elastic Section Modulus 33 8.010E-04m3
Elastic Section Modulus 22 2.690E-04m3

General Parameters
Design Code:
Partial Resistance Factors:
Effective Length:
Section Classification

Section Class:

» G etails

Check for Combined Forces

Utilization Ratio:
Critical Position:

Axial Compression Check

Utilization Ratio:
Critical Position:

» Csiculation Details

Shear Check

U. Ratio Major (2):
Critical Position:
U. Ratio Minor (y):
Critical Position:

» Cskulstion Details

Torsion Check

Utilization Ratio:
<

Steel Column Design - 2C1 (UB 250x250x67)

v X

Cancel

Eurocode 3 (SG)

yMO = 1.00 yM1 = 1.00 yM2 = 1.00
Kx = 1.00 Ky = 1.00 Lx = 1000 mm
Class1

0.052 <1.00v 6.3.3(4)-6.61

(500.00 - 1,000.00) mm

0.011 <1.00v
(5,500.00 - 6,000.00) mm

0.015 < 1.00v
(0.00 - 500.00) mm
0.000 < 1.00v
(500.00 - 1,000.00) mm

0.001 <1.00v

C1=1.00

Ly =6000mm  Lb = 6000 mm

>
>
>
for pass/fail.
>
>
>
>
Buckling length.
>

Check Design = Re-check the design of this column.

Design Report = Prepare the design report.

Parameters Tab > Deflection 2 Manually edit deflection limits.

Click on the triangle ™ next to the title check to drill down to more details.

Change Section =2 Allow you to pick another section = New section will be checked automatically

Show Design Stations =2 List out all the design forces of all load combinations.
Show Diagrams = Show design force diagrams for load cases, load combinations & envelope.

Parameters Tab > Buckling = Input Braced length, Buckling Length Coefficient, Lateral Torsional

Effective lengths are automatically detected & calculated by the program based on restraints provided
by connected members. You can change them if you wish.
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Design Summary

e | » Go to the Parameter tab.

» Tick Manually edit buckling parameters.

VM lly edit the bucki t :
[ ety et e bcingparaneters | > Input various Braced Length
Braced Length Major, Lx: 1000 mm %+ ‘0’ (Zero) means auto-calculate values. Hence, only
Braced Length Minor, Ly: — input values to over-write them.
Buckiing Length Coefficient Major, Kx: 0.000 It is highly recommended you review the auto-
Buckiing Length Coefficient Minor, Ky: ' 500 calculated values and amend to suit your design
assumptions.
Distance between transverse stiffeners: 0mm p
Lateral Torsional Budking Length, Lb: omm| » Go back to Design Summary to check the design.
LTB Moment Coefficient, C1 0.000 +¢ Deflection limits can be modified using similar
steps.
Check Design

»  Pick OK to close the column design dialog.

> Pick Trusses @2 to design the trusses.
Steel Truss Design

I; EI:T: V F Mark al for print ﬁ IDV x

Check Check  Filter a Remove all print marks Design  Detaile Close
Selected All Report Repor

o)

Member Label Storey Print | Section Material Section Class Slenderness Ratio (ki /r) Utilization Ratio Design Status Governing Check
am 2 Cd RHS 150x75x3 S355 Class1 315 > 200 0.45 Pass v (Combined)

T2 2 RHS 150x75x3 $355 Class1 315 > 200 1.20 Fail X (Combined)

T3 2 RHS 150x75x3 5355 Class1 315 > 200 1.20 Fail X (Combined)

214 2 v RHS 150x75x3 S355 Class1 315 > 200 0.48 Pass v (Combined)

Total number of members: 4 ‘

» Double-click on the truss 2T2 to access the detailed steel truss design.
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2T2 - Steel Truss Design

Design
v

I';r I x I - Y = =i IE'T ~ s a ¢ XK

Chedk Check Change Filter Edit Selecte: Report Detailed Reset Show Labels Show Utilization OK Cancel

Selected Al Section Design Parameters Report View Ratios

Type a /O

Members Section Material Slenderness Ratio (kL/r) Deflection (mm) Utilization Ratio Design Status Governing Check

4 Type: Vertical 8
2F2 SHS 75x75x3 5355 43 < 200 - 0.07 < L.00 Pass (Axial Compression)
2F4 SHS 75x75x3 S355 35 < 200 - 0.16 < 1.00 Pass v (Axial Compression)
2F6 SHS 75x75x3 5355 51<0 - 0.01 < 1.00 Pass v (Axial Tension)
2FB SHS 75x75x3 5355 43 < 200 - 0.07 < 1.00 Pass v (Axial Compression)
2F10 SHS 75x75x3 5355 35 < 200 - 0.16 < 1.00 Pass (Axial Compression)

4 Type: Diagonal
2F1 SHS 75x75x3 5355 72 <200 - 0.01 < L.0O Pass v (Axial Compression)
2F3 SHS 75x75x3 §355 67 <0 - 0.14 < 1.00 Pass (Axial Tension)
2F5 SHS 75x75x3 5355 63<0 - 0.34 < 1.00 Pass v (Axial Tension)
2F7 SHS 75x75x3 5355 72 < 200 - 0.01 < 1.00 Pass v (Axial Compression)
2F9 SHS 75x75x3 §355 67 <0 - 0.14 < 1.00 Pass + (Axial Tension)
2F11 SHS 75x75x3 5355 63<0 - 0.33 < 1.00 Pass v (Axial Tension) >

Setected member coloured purpte
100

0.85
0.70

0.50

Total number of members: 14

>
>
>

7 7 R/ R/ R/
0.0 0.0 0.0 0.0 0.0

A\

Reset View =2 Reset the truss diagram to the original orientation.

Show Label 2 Reset the truss diagram to the original orientation.

Show Utilization Ratios = Show Utilization ratio for each member.

Pass / Failed members are shown clearly in Green / Red

Slenderness Ratio failure will not result in FAIL status as it is not a critical criterion (more a warning)
Fail members (UR > 1) will be coloured red in the truss diagram.

The selected member in the table will be coloured purple in the truss diagram.

The truss diagram at the bottom can be zoomed (mouse wheel) & rotated (right-click & drag).

Double-click on the failed bottom chord member = This will bring up detailed member design.
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Steel Bottom Chord Design - BC 14 (RHS 150x75x3)
Ix T &=/ I - T
: T X X
v 28 ] E Q’/’ﬁ
Check Change Design Show Design Show Diagrams Detailed OK Cancel
Design Section Report Stations Report

Design Summary Parameters

Local 2 General Parameters

Design Code: Eurocode 3 (5G)
Partial Resistance Factors:  yM0 = 1.00 yM1 = 1.00 M2=1.00 Cl=2100
Effective Length: Kx = 1.00 Ky = 1.00 I Lx = 1668 mm Ly = 10000 mml Lb = 10000

Section Classification

Local 3 Section Class: Class1
» Calkulation Details

Check for Combined Forces

Utlization Ratio: 1.199 = 100X 6.3.3(4)-6.62
Critical Position: (0.00 - 500.00) mm
Section RHS 150x75x3 P
Section Width 75mm | | Axial Compression Check
Section Height 150mm | iation Ratio: 1.186 = 100X
Wall Thickness 3 mm Critical Position: (1,500.00 - 2,000.00) mm
Section Area 0.0013m2 p  Calagbstion Detai
Shear Area 3 0.0005 m2
Shear Area 2 0.0009 m2 | | Axial Tension Check
Torsional Constant 3.120E-06 m4 Utilization Ratio: 0.222 < 1.00 vV

This bottom member fails in Axial Compression Check & Combined Forces Check. You can increase the
section size or thickness to solve the failure. However, before doing that, let us review effective design
lengths. In the results, General Parameter, notice that for bottom chord, Lx = 1668 mm & Ly =
10,000mm.

e Lxis the Major Braced Length is auto determined = truss panel length
e Lyisthe Minor Braced Length is the entire length of the bottom chord between supports.

%

A& A
L
<€ Ly >

To reduce the minor bracing lengths bottom chord, you can add bracing members at intermediate
locations joining bottoms chords of the adjacent truss.

Alternatively, go to the parameter > Buckling tab to manually edit the bracing lengths.

» If there is a bracing member at the mid-span of the bottom chord, you can change the braced
length Minor, Ly & Lateral Torsional Buckling Length, Lb to 5000mm.

» Click on Design Summary, and the member will automatically be re-checked & result in a pass.

The assumption of top chord is:
e Lxis the Major Braced Length is auto determined = truss panel length

e Lyis the Minor Braced Length is auto determined = purlin spacing

You may want to check the steel beam design. The design interface is similar to the column design.
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Design Status & Design Utilization
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We can view Steel Design Status and Steel Design Utilization to review pass/failure status & design

efficiency quickly.

The design status can be displayed graphically in the plan or 3D window.

» Click on the 3D view to make it active.

» Go to the Review Tab and pick Design Status

=

- OK.

Design Status

| 20

[] waming

[ exvired anaysis
[ S

[] Notoesignea

[ oo notcesign

> Click Visual Interrogation ** & choose Steel Design Utilization Ratios = OK

Active Windows Settings and Visual Interrogation

Visual Interrogation
Scene Settings
Entity Edges
Hiddenline Properties
Visibility Filters
Column Display

Beam Plan Display
Slab Plan Display

FE Contours

Animation

Criteria for recoloring: Reset All Filters

Loads A

Beam Wall Loads

Slab Additional Dead Loads

Slab Live Loads

Members with User Defined Loads

Beams using F.E. Slab Loads

Beams Using F.E. Slab Analysis Results

Members with Temperature Difference
Design

—_—
Strong Column - Weak Beam Check
Joint Shear Check
Building Assessment - Member Damage Regions
Building Risk Assessment Status
Model
Wall Groups
Seismic Isolators

oK

ProtaStructure® ProtaSteel’

Steel Design Utilization Ratios

W0

DUS5—1UU
[Jo7o-08s
W os0-070
[ <050

(] not Designea
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Closing Summary

Congratulations! You have created your first model in ProtaStructure.

We have created, analysed, and designed a simple small model in this basic training guide. The guidance
provided here will give you the necessary knowledge to proceed to an actual project.

For more help and guidance, please refer to Prota Help Centre: https://support.protasoftware.com

We recommend you read the What’s New document for details of new features & enhancements.

The detail drawings of all the members and the general arrangement drawings can be automatically
produced and managed in ProtaDetails (concrete) & ProtaSteel (steel). We recommend you proceed to
read the ProtaDetails & ProtaSteel Quick Start Guide as the next step.

Should you have any technical support requests or questions, please do not hesitate to contact us at all
times through globalsupport@protasoftware.com or asiasupport@ protasoftware.com (Asia Pacific).

Our dedicated online support centre is available to help you get the most out of Prota’s technology
solutions with our responsive technical support team.

ProtaStructure’
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